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basics such as how to create walls, floors, roof, but it also covers more advanced topics 
such as creating a complex object, preparing construction documents, and modeling 
mechanical and structural systems. 

This book is an open education platform for Architecture and Civil Engineering 
students to learn Revit and provides students with adequate, coherent, consistent, and 
cost-saving educational resources. It includes both text and video of each chapter to 
help students have access to both step-by-step written instructions and videos of each 
lesson because software instructions are mostly narratives and difficult for students to 
visualize the procedures and follow the instructions. 

BIM is one of the most recent developments influencing the architecture, 
engineering, and construction (AEC) industry. BIM provides the opportunity to improve 
poor communication and information sharing among building owners, architects, 
engineers, builders, and public authorities. It enhances collaboration among project 
teams and improves AEC performance by decreasing project cost, increasing 
productivity and quality, and reducing project delivery time. Students pursuing a 
degree in a related field should gain knowledge and skills about BIM and its tools. 

The book is composed of 15 chapters covering various topics. Each chapter starts with 
the basics of creating elements and builds on students’ previous knowledge and takes 
them further to develop BIM modeling skills using Revit. Each chapter presents a mix of 
written instructions, various activities, and videos to help students with various learning 
needs. Completing each chapter is the same as completing an assignment and skills 
developed can be used to work on a class project defined by the course instructor or 
found online. 
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Chapter 1: Revit Interface 

1.1 OPENING A REVIT SAMPLE PROJECT 

1. Start the Revit application 
2. Once Revit Home loads, click the Open button 
3. Navigate to the C:/Program Files/Autodesk/Revit 2019/Samples/ 
4. Select the file rac_basic_sample_project 
5. Click Open 

Figure 1.1 Opening a Revit sample project 
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1.2 BECOMING FAMILIAR WITH THE REVIT 
INTERFACE 

Figure 1.2 Revit Interface components 
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Description of Revit components 

Tab Organizes tools based on the main function such as Architecture, 
View, or Massing. 

Ribbon Provides tools to create elements or components of a project or 
family along with other commands 

Tools Individual icons available to initiate a command 

Option 
Bar Displays options available to alter the function of a command 

Type 
Selector 

Identifies the currently selected family type and provides a 
drop-down menu from which a different type can be chosen such as 
a wall or roof material or construction 

Properties 
Palette 

Used to view or modify the parameters that define the properties of 
elements or canvas 

Project 
Browser 

Provides access and organizes the views, schedules, and sheets of the 
project 

Status Bar Provides tips or hints on what to do with the selected element or 
component 

Info 
Center Provides searchable help options and the app store icon 

View Cube Available in 3D view and adjusts the view settings 

Navigation 
Bar Available in 3D and 2D to adjust the zoom and view settings 

View 
Control 
Bar 

Quick access to functions that affect the current view 

1.3 ACCESSING INTERFACE COMPONENTS 

1. Above the ribbon, click the View tab 

2. Click the User Interface icon 
3. One at a time un-check and check each box to become familiar with the 

components and their names. For help, reference Figure 1.3 
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Figure 1.3 Customizing the User Interface 

Opening the Ribbon 

1. Above the ribbon, to the right of the tabs, click the icon  as shown in Figure 1.4 

◦ Option 1: Click the drop-down arrow and click the option individually 
◦ Option 2: Click the icon to cycle through the options 
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Figure 1.4 Ribbon display options 

Opening the Properties Palette 

1. There are two ways of accessing the Properties Palette 

◦ Option 1: shown in Figure 1.3 

▪ Click the View tab 
▪ Click the User Interface icon 
▪ Click Properties Palette 

◦ Option 2: shown in Figure 1.5 

▪ Right-click on the canvas 
▪ Click Properties Palette 
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Figure 1.5 Accessing the Properties Palette 

Opening the Project Browser 

1. There are two ways of accessing the Project Browser 

◦ Option 1: shown previously in Figure 1.3 

▪ Click the View tab 

▪ Click the User Interface icon 
▪ Click Properties Palette 

◦ Option 2: shown in Figure 1.6 

▪ Right-click on the canvas 
▪ Click Browsers 
▪ Click Properties Palette 
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Figure 1.6 Accessing the Project Browser 

1.4 PROJECT BROWSER 

Open Views 

1. Open the following views from the Project Browser by double-clicking the name 
as shown in Figure 1.7 

◦ Floor Plan: Level 1 
◦ 3D views: {3D} 
◦ Elevation: West 
◦ Schedule: Planting Schedule 
◦ Sheet: A101 – Site Plan 
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Figure 1.7 Opening views from the Project Browser 

Place family elements 

1. In the 3D view, scroll down the Project Browser to Families 
2. Click the + icon to expand the section 
3. Expand Planting 
4. Expand RPC Tree-Deciduous as shown in Figure 1.8 
5. Click and drag to place a Hawthorne-25 
6. Place 5 more of any tree 
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Figure 1.8 Families in the Project Browser 

TIP 

Press the Space bar to rotate an element 

Project Browser search bar 

1. Right-click in the Project Browser 
2. Choose the option to Search 
3. Type Bathroom 
4. Toggle through the matches by clicking the Next and Previous buttons as shown 

in Figure 1.9 
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Figure 1.9 Project Browser Search 

1.5 PROPERTIES PALETTE 

Type Selector 

1. In the 3D view, select the roof 
2. Click the Type Selector 
3. Choose Warm Roof – Timber as shown in Figure 1.10 
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Figure 1.10 Type Selector: Warm Roof – Timber 

Crop View 

1. In the West elevation view, go to the Properties Palette 
2. Scroll down to the Extents section 
3. Click to check the box next to Crop View 
4. Click to check the box next to Crop Region Visible 
5. Click and hold a blue dot  to adjust the boundary box 
6. Pull the blue dot over the elevation drawing and release the blue dot 
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Figure 1.11 Crop Box Extents 

Section Box 

1. In the 3D view, go to the Properties Palette 
2. Scroll down to the Extents section 
3. Click to check the box next to Section Box 
4. Click on the Section box 

5. Use the double blue arrows  to adjust the section box extents 
6. Pull in a side of the cube to cut through the building as shown in Figure 1.12 
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Figure 1.12 Section Box 

TIP 

If the Section Box does not show up, refer to Chapter #: Troubleshooting and 
Tips 

 

1.6 NAVIGATING THE CANVAS 

View Cube 

The View Cube consists of two components; the Cube and the Compass as shown in 
Figure 1.13. 

1. The Cube is used to pivot around the 3D model using preset views by clicking the 
corners, edges, and faces. 

◦ Or click and hold the Cube while dragging the cursor around to pivot both 
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horizontally and vertically. 

2. The Compass pivots around the 3D model without changing the view vertically. 
Click and hold on the compass and drag the cursor left and right 

Figure 1.13 View Cube 

2D Wheel 

1. The top icon is called the Full Navigation Wheel. Click this icon and hover the 
cursor over the canvas. 

◦ Options available to adjust the view: Zoom, Orbit, Rewind, Pan, Walk, Center, 
Look and Up/Down 

2. In both 2D and 3D views, there are two methods for zooming. 

◦ Use the 2D wheel to zoom incrementally by options as shown in Figure 1.14 
◦ Use the cursor scroll wheel to zoom in and out 
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Figure 1.14   2D Wheel (left) and Full Navigation Wheel (right) 

Panning 

1. Click the cursor scroll wheel anywhere on the canvas and hold it down 
2. Drag the cursor in any direction to move the around the canvas 

Hidden Objects 

1. Select an element in either 2D or 3D 
2. Right-click then select Hide in View 
3. Choose one of the following 

◦ Hide Element – will hide only the items selected 
◦ Hide Category – will hide all items under the same category 

4. Click the Reveal Hidden Items icon  on the View Control Bar to see hidden 
elements 

5. Select the element to reveal 
6. Right-click then select Unhide in View 
7. Choose either Element or Category 

8. Click the Reveal Hidden Items icon  to close the reveal 
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Detail Level 

1. Click the Detail Level icon  on the View Control Bar to change the level of detail 
between Coarse, Medium, and Fine 

Visual Style 

1. Click the Visual Style icon  on the View Control Bar to change the project view 
between Wireframe, Hidden Line, Shaded, Consistent Colors, Realistic, or Ray 
Trace. 

 
Revit Interface Video Tutorial 
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Chapter 2: Walls, Curtain Walls, 
Windows and Doors 

2.1 TYPES OF WALLS 

Basic Walls 

Generic 

A Basic Wall is a blank element with no applied materials. The default sizes available 
are 6, 8, and 12 inches thick. A material, pattern, texture, or color can be applied, and 
its depth altered. Other examples of Basic Wall are Generic Masonry, Generic Filled, 
Generic Brick, Brick on CMU, Brick on Metal Stud, CMU Insulated, CMU on Metal Stud, 
EIFS on Metal Stud, Interior Partition, Retaining wall, and GWB on Metal Stud. 

Figure 2.1 Basic Wall Generic – 6” 

Generic Masonry 

A generic masonry wall has a solid masonry material applied to it. The default sizes are 
6, 8 and 12 inches thick. 
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Figure 2.2 Basic Wall Generic – 6” Masonry 

Generic Filled 

A generic filled wall comes 8 inches thick and shows poched in section. 

Figure 2.3 Basic Wall Generic – 8” – Filled 

Generic Brick 

A generic brick wall follows the nominal thickness of a 4-inch brick wall. 
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Figure 2.4 Basic Wall Generic – 4” Brick 

Exterior walls 

Exterior Brick on CMU 

In section, this wall follows the correct layering of materials required by code to install 
brick over a structural CMU (Concrete Masonry Unit) wall. 

Figure 2.5 Basic Wall Exterior – Brick on CMU 

Exterior Brick and CMU on MTL stud 

In section, this wall follows the correct layering of materials required by code to install 
brick over a structural CMU (Concrete Masonry Unit) wall. 
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Figure 2.6 Basic Wall Exterior – Brick on CMU on MTL. Stud 

Exterior Brick on MTL. Stud 

In section, this wall follows the correct layering of materials required by code to install 
brick on a structural metal stud wall. 

Figure 2.7 Basic Wall Exterior – Brick on Mtl. Stud 

Exterior CMU Insulated 

In section, this wall follows the correct layering of materials required by code to install 
insulated CMU blocks. 
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Figure 2.8 Basic Wall Exterior – CMU Insulated 

Exterior CMU on MTL. Stud 

In section, this wall follows the correct layering of materials required by code to install 
CMU as the exterior facing with a metal stud wall on the interior. 

Figure 2.9 Basic Wall Exterior – CMU on Mtl. Stud 

Exterior EIFS on Mtl. Stud 

In section, this wall follows the correct layering of materials required by code to install 
an Exterior Insulation and Finishing System on the exterior facing of a metal stud wall. 
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Figure 2.10 Basic Wall Exterior – EIFS on Mtl. Stud 

Interior Walls 

Interior Partition (1-hr) 

An interior partition wall has metal studs at its core with 1 hour rated gypsum board on 
both facings. The default wall sizes are 3-1/8”, 4-7/8” and 5-1/2” thick. 

Figure 2.11 Basic Wall Interior – 3 1/8” Partition (1-hr) 

Interior Partition (2-hr) 

An interior partition wall has metal studs at its core with 2 hour rated gypsum board on 
both facings. The default wall sizes are 5” and 6-1/8” thick. 
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Figure 2.12 Basic Wall Interior – 5” Partition (2-hr) 

Other Walls 

Retaining 12” Concrete 

A retaining wall is made from concrete that is cast-in-place, on-site. 

Figure 2.13 Basic Wall Retaining – 12” Concrete 

Soffit ½” GWB and Metal Stud 

A soffit is usually the eave overhang that connects the roof back to the exterior face of 
the wall. It can also be the material area underneath a balcony or other such elements. 
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Figure 2.14 Basic Wall Soffit – ½” GWB Metal Stud 

Foundation Concrete 

Foundation concrete is used underneath structural walls to create a soil retaining 
barrier. These elements are often referred to as footings and are always thicker than the 
structural wall above. 

Figure 2.15 Basic Wall Foundation – 12” Concrete 

Revit Curtain Walls 

Curtain Wall 

A glass curtain wall system is connected from the building’s floor plates typically seen 
on high-rise buildings. These walls do not carry any loads of floors, roofs, or structure to 
the ground. The Curtain Wall type in Revit is a blank glass wall with no set parameters 
as a base for grids and mullions to be designed. 
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Figure 2.16 Curtain wall in 3D view and cut in section 

Exterior Glazing 

Exterior Glazing has a preset grid where the parameters can be altered and designed 
through the Properties Palette. 

Figure 2.17 Exterior Glazing in 3D view and cut in section 
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Storefront 

A storefront system is typically installed between floor plates typically low-rise and 
commercial buildings. The Storefront wall option offers a ready-to-go wall with a set 
grid and set mullions that can be altered and designed through the Properties Palette. 

Figure 2.18 Storefront in 3D view and cut in section 

Stacked Wall 

Exterior Brick over CMU with Metal Stud 

The Revit Stacked Wall option offers a wall built from two different materials stacked 
one on top of the other. In this specific type the lower portion is a CMU block and the 
top is a Brick wall tied to a metal stud wall. These walls can be modified or designed 
using the Properties Palette. 
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Figure 2.19 Stacked Wall Exterior – Brick over CMU w Metal Stud 

2.2 CREATE AND MODIFY WALLS 

This Building Information Modeling book will continually build in one tutorial file 
through every chapter. 

1. Start a New Project and select the Architectural Template 

2. Use Figure 2.20 to add the levels  in an elevation view 
3. Use Figure 2.21 to add grid lines in the Level 1 view at  20 feet. Make sure to lock the 

grid lines using the pin tool 

Figure 2.20 Project Levels in the East elevation 
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Figure 2.21 Grid Lines in the Level 1 view 

Create a wall using the line tool 

1. In the Level 1 view, click to open the Architecture tab 

2. Click the Wall icon  from the Ribbon, under the Build panel 
3. Use the Type Selector to choose the Generic – 12” 
4. In the Properties Palette set the following parameters 

◦ Location Line: Wall Centerline 
◦ Base Constraint: Level 1 
◦ Top Constraint: Up to level: Roof Level 

5. Under the Draw panel, click the Line tool 
6. Click once to begin a wall from Figure 2.22 
7. Drag the cursor and type the dimension 
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8. Press Enter to complete the first wall 
9. Drag and type the dimension until all 5 walls are placed 

10. Press ESC twice to exit the command 

Figure 2.22 Generic 12” walls in plan view and 3D view 

TIP 

1. The Options Bar is also used to set parameters 

2. To view the model in 3D, click the Default 3D View icon  from the 
Quick Access Tool Bar 

Modify a wall 

1. In the Level 1 or 3D view, click to open the Architecture tab 

2. Click the wall icon 
3. Use the Type Selector to choose the Generic – 4″ Brick 

4. Click the Edit Type button 
5. Click the Duplicate button 
6. Rename the duplicate “Generic – 4” Brick w/ Reveals 
7. In the Type Properties window, next to Structures, click Edit… 
8. At the bottom of the window, click the Preview button to view the wall system 
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9. Use the View drop-down menu to choose Section 
10. Click the Reveals button 
11. Click the Add button 
12. Select the Default line 
13. Navigate through the Imperial Library to find the profile 

◦ Profiles folder 
◦ Wall folder 
◦ Choose the Wall Sweep – Brick Soldier Couse 
◦ Click Open 

14. Use the drop-down to change from Default to Reveal – Brick Course: 3 Brick 
15. Click OK to close the Reveals, Edit Assembly, and Type Properties windows 
16. In the 3D view, select the buildings West wall 
17. Use the Type Selector to change the wall to CMU – Insulated 
18. Change the Top Constraint to Level 3 
19. Open the Level 3 View 

20. Click the wall icon 
21. Change the Top Constraints to Roof 
22. Draw a wall to fill in the top half of the West wall elevation 
23. Select the CMU – Insulated wall 

24. Click the Edit Profile icon 
25. Following Figure 2.23 redraw the profile of the wall 

26. Click the green checkmark  to complete the modified wall 

27. With the modified CMU wall selected click the Attach Top/Base icon  on the 
ribbon. 

28. Select the Brick wall above the CMU wall 
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Figure 2.23 Modified profile on CMU wall 

Figure 2.24 Stacked exterior wall shown in the Level 3 plan view and in the 3D view 
 

TIP 

If the exterior facade is not facing outward, click the double arrows or 
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press the Space bar to change its direction. 

Create interior walls 

1. In the Level 1 view click the Architecture tab 

2. Click the Wall icon  from the ribbon, under the Build panel 
3. Use the Type Selector to choose the Interior 4-7/8” Partition (1-hr) 
4. In the Properties Palette set the following parameters 

◦ Location Line: Wall Centerline 
◦ Base Constraint: Level 1 
◦ Top Constraint: Up to level: Level 2 

5. Under the Draw panel, click the Line tool 
6. Draw 8 enclosed rooms as shown in Figure 2.25 
7. Click the Architecture tab 

8. Click the Wall icon 
9. Use the Type Selector to choose the Interior 3-1/8” Partition (1-hr) 

10. In the Properties Palette change the following parameters 

◦ Top Constraint: Unconnected 
◦ Unconnected Height: 3’6” 

11. Refer to Figure 2.26 to draw the cubicle partition walls 
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Figure 2.25 Eight enclosed rooms with dimension lines 
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Figure 2.26 Interior walls with dimension lines 

TIP 

1. The Options Bar is also used to set parameters 
2. Press the ESC key once to discontinue a wall and begin a new wall in a 

different location 
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Create curved walls 

1. In the Level 1 view, select the Wall icon  from the ribbon, under the Build panel 
2. Use the Type Selector to choose the Interior 4-7/8” Partition (1-hr) 
3. In the Properties Palette set the following parameters 

◦ Location Line: Wall Centerline 
◦ Base Constraint: Level 1 
◦ Top Constraint: Up to level: Level 2 

4. Under the Draw panel, use the Start-End-Radius Arc tool  and the line tool  to 
draw the rooms. Refer to the dimensions in Figure 2.27 

5. Create 2 more identical rooms using the Copy  and Paste icons 

6. Center each on the intersection grid lines using the Move tool 

Figure 2.27 Dimensions for the room with curved walls 

Add an opening 

1. In the 3D view, Click the Architecture tab 

2. On the ribbon, click the Wall icon  from the Opening panel 
3. Select the wall to cut an opening in 
4. The cursor will change to a draw rectangle tool 
5. Click once to begin the opening 
6. Drag the cursor diagonally and click to place the opening 
7. Press the ESC key twice to exit the command 
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8. Select the opening and use the witness lines to change the dimensions as shown 
in Figure 2.28. 

9. Create identical openings for the other 2 rooms 

Figure 2.28 Wall Opening with witness line dimensions 

Create a Curtain Wall 

1. Click the Architecture tab 

2. In the Level 2 view, click the Wall icon from the ribbon, under the Build panel 
3. Use the Type Selector to choose the Curtain Wall 1 
4. In the Properties Palette set the following parameters 

◦ Location Line: Wall Centerline 
◦ Base Constraint: Level 1 
◦ Top Constraint: Up to level: Level 2 

5. Under the Draw panel, choose the Line tool 
6. Draw one wall as shown in Figure 2.29 
7. Press the ESC key twice to exit the command 
8. In the 3D view, select the Curtain Grid icon  from the ribbon, under the Build 

panel 
9. Hover the cursor over the curtain walls top edge and click to place vertical grid 

lines every 5 feet as shown in Figure 2.30 
10. Hover the cursor over the curtain walls side edge and click to place horizontal grid 

lines every 11 feet as shown in Figure 2.30 
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Figure 2.29 Curtain Wall 1 shown in plan view and in 3D view 
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Figure 2.30 Curtain Wall 1 with added grid lines 

Modify a Curtain Wall 

1. Click the Architecture tab 

2. In the Level 1 view, select the Wall icon  from the ribbon, under the Build panel 
3. Use the Type Selector to choose the Curtain Wall 1 
4. In the Properties Palette set the following parameters 

◦ Location Line: Wall Centerline 
◦ Base Constraint: Level 1 
◦ Top Constraint: Up to level: Roof Level 
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5. Click the Edit Type button  in the Properties Palette 
6. The Type Properties window will open, click the Duplicate button as shown in 

Figure 2.31 
7. Name the Duplicate My Curtain Wall 
8. Change the following parameters 

◦ Construction 

▪ Curtain Panel: System Panel: Glazed 
▪ Join Condition: Border and Vertical Grid Conditions 

◦ Vertical Grid 

▪ Layout: Fixed Distance 
▪ Spacing: 5’ 0” 

◦ Horizontal Grid 

▪ Layout: Fixed Distance 
▪ Spacing: 11’ 0” 

◦ Vertical Mullions 

▪ Interior Type: Rectangular Mullion: 1.5” X 2.5” rectangular 
▪ Border Type 1: Rectangular Mullion: 1.5” X 2.5” rectangular 

◦ Horizontal Mullions 

▪ Interior Type: Rectangular Mullion: 1.5” X 2.5” rectangular 
▪ Border Type 1: Rectangular Mullion: 1.5” X 2.5” rectangular 

◦ Click OK to accept parameters 

9. Under the Draw panel, click the Line tool 
10. Draw three walls as shown in Figure 2.32 
11. Press the ESC key twice to exit the command 

12. Select the Modify icon  on the ribbon 
13. Select the vertical corner mullion 
14. Right–click and click the Select Mullions option, then click On Gridline from the 

submenu 

15. On the ribbon, click the Unpin tool 
16. Use the Type Selector to change the mullion to L Corner Mullion: 5” X 5”, use Figure 

2.33 for reference 
17. Repeat steps 11 through 15 for the other corner condition 

18. On the ribbon, select the Mullion icon 
19. Select the top edge of the curtain wall to add mullions to finish off the wall as 

shown in Figure 2.33 
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Figure 2.31 Curtain wall Type Parameters 
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Figure 2.32 My Curtain Wall in plan view and in 3D view 

Figure 2.33 Modified corner mullions (left) and added top mullion (right) 
 

TIP 
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Hover over an item and press the Tab key to cycle through the selection 
options 

 

Embed and edit a curtain wall 

1. Change the South curtain wall type to Storefront 

2. Click the Edit Type button  in the Properties Palette 
3. The Type Properties window will open, click the Duplicate button 
4. Name the Duplicate My Storefront Wall 
5. Change the following parameters 

◦ Vertical Grid 

▪ Layout: Fixed Distance 
◦ Horizontal Grid 

▪ Spacing: 11’ 0” 
◦ Click OK to accept the changes 

6. Hover the cursor over one of the bottom two center mullions 

7. Select the mullion and click the Unpin tool  on the ribbon 
8. Press the Delete key 
9. Repeat steps 7 through 9 on the other bottom center mullion 

10. Hover the cursor over one of the center panes of glass 

11. Select the glass pane and click the Unpin tool  on the ribbon 

12. In the Properties palette, click the Edit Type button 
13. The Type Properties window will open 
14. Click the Load button 
15. Open the Doors folder 
16. Select the Door-Curtain-Wall-Single-Glass 
17. Click Open 
18. Click OK 
19. Select the other center glass pane 

20. Select the glass pane and click the Unpin tool  on the ribbon 
21. Use the Type Selector to change the glass pane to the Door-Curtain-Wall-Single-

Glass 
22. In the Level 1 view, adjust the door swing directions as shown in Figure 2.34 
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Figure 2.34 Storefront doors shown in plan and in 3D view 
 

TIP 

1. Hover over an item and press the Tab key to cycle through the selection 
options 

2. With an element selected, press the Space bar to cycle through the 
rotations or position options 

 

 

2.3 PLACING DOORS 

1. Click the Architecture tab 

2. In the Level 1 view, click the Door icon  from the ribbon, under the Build panel 
3. Use the Type Selector to choose the Single-Flush 36” X 84” 
4. Click to place doors as shown in Figure 2.35 
5. Select each door and use the witness lines to adjust the placement to 2’6” 

between the open door and the neighboring wall. See Figure 2.35 for reference 
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Figure 2.35 Placed doors in plan view and in 3D view 
(One wall in the 3D view is hidden to better show the door placements) 

2.4 PLACING WINDOWS 

1. Click the Architecture tab 

2. In the Level 1 view, select the Window icon  from the ribbon, under the Build 
panel 

3. Use the Type Selector to choose the Fixed 36” X 72” window 
4. Click to place the windows as shown in Figure 2.36 

5. On the ribbon, select the Align Dimension icon 
6. Hover the cursor over the center of the window, when the centerline highlights 

blue, click to place a dimension line 
7. Click to add the remaining 3 windows. 
8. Drag the dimension line outside of the building 
9. Click anywhere on the dimension line to finish placing 

10. Press the ESC twice to exit the command 

11. Select the dimensions and click the  to activate equally spacing the windows 
12. Follow steps 5 through 11 for the second set of windows 
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Figure 2.36 Placed windows in plan view and in 3D view 
 
Wall Video Tutorial 1 
Wall Video Tutorial 2 
Wall Video Tutorial 3 
Curtain Walls, Door and Windows 
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Chapter 3: Floors, Roofs and 
Ceilings 

3.1 TYPES OF FLOORS 

Basic Floor 

Generic Floor 

A Generic Floor is a blank element with no applied materials. The default size is 12 
inches thick. A material, pattern, texture, or color can be applied, and its depth altered. 

Figure 3.1 Floor Generic – 12” 

Generic Filled 

A generic filled floor comes 12 inches thick and shows poched in section. 
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Figure 3.2 Floor Generic – 12” – Filled 

Detailed Floors 

LW Concrete on Metal Deck 

In section, this wall follows the correct layering of materials required by code to install
Light Weight concrete over metal decking material. 

Figure 3.3LW Concrete on Metal Deck 

3” LW Concrete on 2” Metal Deck 

In section, this wall follows the correct layering of materials required by code to install 
Light Weight concrete over metal decking. The 3 inches refers to the thickness of 
concrete above the corrugated metal while the 2 inches refers to the depth of the 
corrugated metal deck channels. 
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Figure 3.4 Floor 3” LW Concrete on 2” Metal Deck 

Steel Bar Joist 14” – VCT on Concrete 

In section, this wall follows the correct layering of materials required by code to install 
vinyl composition tile over lightweight concrete and metal decking. This floor system 
lays on top of structural steel joists that are 14” in depth. 

Figure 3.5 Floor Steel Bar Joist 14” – VCT on Concrete 

Wood Joist 10” – Ceramic Tile 

In section, this wall follows the correct layering of materials required by code to install 
ceramic tile over a wooden structure. This floor system lays on top of structural wood 
joists that are 10” in depth. 
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Figure 3.6 Floor Wood Joist 10” – Ceramic Tile 

Wood Joist 10” – Wood Finish 

In section, this wall follows the correct layering of materials required by code to install 
wood flooring over a wooden structure. This floor system lays on top of structural wood 
joists that are 10” in depth. 

Figure 3.7 Floor Wood Joist 10” – Wood Finish 

Wood Truss Joist 12” – Carpet Finish 

In section, this wall follows the correct layering of materials required by code to install 
carpet flooring over a wooden structure. This floor system lays on top of structural wood 
joists that are 12” in depth. 
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Figure 3.8 Floor Wood Truss Joist 10” – Carpet Finish 

3.2 CREATE AND MODIFY FLOORS 

Continue building on the project from Chapter 2: Walls, Curtain Walls, Doors, and 
Windows. 

Create a floor using the Line tool 

1. Click the Architecture tab 

2. In the Level 1 view, click the Floor icon  from the ribbon, under the Build panel 
3. Use the Type Selector to choose the Generic – 12” 

4. Under the Draw panel, click the Line tool 
5. Draw a 20’ 0” X 80’ 0” floor as shown in Figure 3.9 

6. On the ribbon, click the green checkmark  to complete the floor 
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Figure 3.9 Floor shown in plan view and finished floor in 3D view 

Create a floor using the Pick line tool 

1. Click the Architecture tab 

2. In the Level 1 view, click the Floor icon  from the ribbon, under the Build panel 
3. Use the Type Selector to choose the Generic – 12” 

4. Under the Draw panel, click the Pick Line tool 
5. Hover the cursor over any wall, use the Tab key to cycle through the selection 

options until the centerline is highlighted with a blue line, click to select the line. 
Follow this step until all boundaries have been selected as shown on the left in 
Figure 3.10 

6. Click the green checkmark  to complete the floor 
7. Select the floor 

8. On the ribbon, click the Copy icon 

9. On the ribbon, click the Paste icons  drop-down arrow 

10. Click the Aligned to Selected Levels 
11. The Select Levels window will open. Hold down the Control key and click levels 2, 3 

and 4 
12. Click OK. The result is shown on the right in Figure 3.10 
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Figure 3.10 Floor shown in plan view and finished floor in 3D view 
(In the 3D view two walls have been hidden to show the multiple floor plates) 

Edit a floor 

1. Click the Architecture tab 
2. Open the Level 2 plan view from the Project Browser 
3. Select the floor 

4. On the ribbon, click the Edit Boundary icon 

5. Use the Line tool  to add a 5-foot-wide mezzanine as shown in Figure 3.11 
6. Click the green checkmark  to complete the floor 
7. Repeat steps 1 through 5 for Levels 3 and 4 floors. 
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Figure 3.11 Modified floor shown in plan view and finished floor in 3D view 
 

TIP 

Hover the cursor over the edge of the floor and press the Tab key to cycle 
through the selection options 

Create a slope using the Slope Arrow 

1. Click the Architecture tab 

2. In the Level 1 view, click the Floor icon  from the ribbon, under the Build panel 
3. Use the Type Selector to choose the Generic – 12” 

4. Create a 4’ 0” X 12’ 0” floor using the line tool  as shown in Figure 3.12 

5. Select the Slope Arrow icon  and draw the arrow from the right to the 
left 

6. In the Properties Palette, change the Height Offset from Level to -1’ 0” 
7. Click the green checkmark  to complete the floor 
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Figure 3.12 Sloped floor plan shown in plan view and 3D view 

Create a slope using the Split Line tool 

1. Click the Architecture tab 
2. Select the entryway floor 

3. On the ribbon, click the Edit Boundary icon 

4. Use the Line tool  and Trim tool  to cut off a 5ft X 5ft corner from the slab as 
shown in Figure 3.13 

5. Click the green checkmark  to complete the floor 
6. Select the floor 

7. On the ribbon select the Add Split Line icon 
8. In the Properties Palette, change the Height Offset from Level to -1’ 0” 
9. Add split lines as shown in Figure 3.13 

10. Select the center green dashed line 
11. Select the witness line dimension box that appears 
12. Type -1’ 0” 
13. Press the Enter key 
14. Press the ESC key twice to exit the command 
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Figure 3.13 Split line slope shown in plan view and 3D view 

Add an Opening By Face 

1. Click the Architecture tab 

2. In the 3D view, click the By Face icon  on the ribbon under the Opening panel 
3. Select the Level 4 floor 
4. Draw a 15ft X 15ft square as shown in Figure 3.14 

5. Use the move tool  to center the opening as shown in Figure 3.14 
6. Click the green checkmark  to complete the floor 
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Figure 3.14 Opening by Face shown in plan view and 3D view 

Add Shaft Opening 

1. Click the Architecture tab 

2. In the Level 2 view, select the Shaft icon  on the ribbon, under the Opening 
panel 

3. In the Properties Palette, change the following parameters 

◦ Base Constraint: Level 2 
◦ Base Offset: -1’ 0” 
◦ Top Constraint: Up to Level 6 
◦ Top Offset: 1’ 0” 

4. Draw a 15ft X 9ft as shown in Figure 3.15 

5. Click the green checkmark  to complete the floor 
6. In the 3D view, reposition the View Cube to verify the shaft opening cuts through 

all 3 floors 
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Figure 3.15 Shaft Opening shown in plan view and 3D view 
(Two walls are Hidden from view to show the shaft cutting through multiple floors) 

3.3 ROOFS 

Basic Roofs 

Generic Roofs 

A Generic Roof is a blank element with no applied materials. The default sizes are 9, 12,
and 18 inches thick. A material, pattern, texture, or color can be applied, and its depth 
altered. 

Figure 3.16 Basic Roof Generic – 9” 
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Generic Filled 

A generic filled roof comes 12 inches thick and shows poched in section. 

Figure 3.17 Basic Roof Generic – 12” – Filled 

Detailed Roofs 

Steel Truss – Insulation on Metal Deck – EPDM 

In section, this roof follows the correct layering of materials required by code to install
EPDM (Ethylene Propylene Diene Terpolymer) and rigid insulation over a steel 
structure. 

Figure 3.18 Basic Roof Steel Truss – Insulation on Metal Deck – EPDM 

Wood Rafters 8” – Asphalt Shingle – Insulated 

In section, this roof follows the correct layering of materials required by code to install 
asphalt shingles over a wooden structure. 
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Figure 3.19 Basic Roof Wood Rafter 8” – Asphalt Shingle – Insulated 

3.4 CREATE AND MODIFY ROOFS 

Create a roof using the Line tool 

1. Open the Roof floor plan view in the Project Browser 
2. In the Properties Palette, under the Underlay section, change the Range: Base 

Level to Level 4 

3. Select the Roof icon  from the Ribbon, under the Build panel 
4. Use the Type Selector to choose the Generic – 12” 

5. Under the Draw panel, choose the Line tool  or the Pick Lines tool 
6. On the Options Bar, change the following parameters 

◦ Uncheck the box next to Defines Slope 
◦ Overhang: 2’ 0” 

7. Draw or select lines to outline the building as shown in Figure 3.20 
8. Select the four walls shown in Figure 3.20 and check the box next to Defines Slope 

in the Properties Palette 

9. On the ribbon, click the green checkmark  to complete the floor 
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Figure 3.20 Roof outline in plan view and finished roof in 3D view 

Attaching walls to a roof 

1. Select an exterior wall on the model 

2. Select the Attach Top/Base icon  from the ribbon, under the Modify Wall panel 
3. Select the Roof 
4. Repeat steps 1 through 3 until all the walls are attached to the roof 
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Figure 3.21 Attached walls to roof in 3D view 
 

TIP 

Hold the Control Key down to select more than one wall at a time 

Editing a roof boundary 

1. In the Roof level, select the roof 

2. Select the Edit Footprint icon 
3. Check the box by Defines Slope for all walls in the Properties Palette as shown in 

Figure 3.22 
4. In the Properties Palette change the Slope to 6” / 12” 

5. Click the green checkmark  to complete the Roof 

Chapter 3: Floors, Roofs and Ceilings  |  61

www.dbooks.org

https://www.dbooks.org/


Figure 3.22 Modified roof in plan view and finished roof in 3D view 

Roof by Extrusion 

1. In the 3D view, Click the Roof down arrow and select the Roof by Extrusion icon 

2. The Work Plane window will open, click the Pick a plane option 
3. Click OK 
4. Select the straight wall on the right of the curved wall as shown in Figure 3.15 
5. The Roof Reference Level and Offset window will open, change the following 

parameters 

◦ Level: Roof 
◦ Offset: -1’ 0” 
◦ Click OK 

6. Select the Start-End-Radius Arc tool 
7. Hover the cursor over the top of the wall, when highlighted click to start placing an 

extrusion 
8. In the Properties Palette change the following parameters 

◦ Extrusion Start: 2’ 0” 
◦ Extrusion End: -10’ 0” 

9. Repeat Steps 1 through 8 and create two more arc extrusions 

10. Click the green checkmark  to complete the extrusion 
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Figure 3.23 Arc roof extrusion in plan view and in 3D view 

3.5 CEILINGS 

Basic Ceilings 

Generic Ceiling 

A Generic Ceiling is a blank element with no applied materials. A material, pattern,
texture, or color can be applied, and its depth altered. 

Figure 3.24 Basic Ceiling Generic 

Chapter 3: Floors, Roofs and Ceilings  |  63

www.dbooks.org

https://www.dbooks.org/


Detailed Ceilings 

ACT System 

In section, this ceiling follows the correct layering of materials required by code to install 
an Acoustic Ceiling Tile System. The tiles come 2ft X 2ft and 2ft X 4ft. 

Figure 3.25 Compound Ceiling ACT system 

GWB on Metal Stud 

In section, this ceiling follows the correct layering of materials required by code to install 
the Gypsum Wall Board over a metal frame ceiling. 

Figure 3.26 Compound Ceiling GWB on Metal Stud 
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3.6 CREATE AND MODIFY CEILINGS 

Create a ceiling 

1. In the Project Browser, double-click to open the Level 1 Ceiling Plan 
2. Click on the Architecture tab. 

3. On the ribbon, under Build, select the Ceiling icon 
4. Use the Type Selector to choose the 2’x4’ ACT System 

5. On the ribbon, choose the Automatic Ceiling icon 
6. Hover the cursor over the main space, when the interior faces highlight red, click 

to apply the ceiling as shown in Figure 3.27 for reference 
7. Use the Type Selector to choose the 2’x2’ ACT System 

8. On the ribbon, choose the Sketch Ceiling icon 

9. Use the Line tool  and draw around the interior faces of the offices as shown in 
3.27 for reference 

10. On the ribbon, click the green checkmark  to complete the ceiling 

Figure 3.27 ACT Systems shown in ceiling plan and in 3D view 
(In the 3D view two walls have been hidden from view to better show the ceiling 
system) 

Edit ceiling materials 

1. Open the Level 4 plan view from the Project Browser 
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2. In the Architecture tab, click the Ceiling icon 
3. Use the Type Selector to choose the GWB on Mtl. Stud 
4. In the Properties Palette, change the Height Offset from Level to 12’ 0” 

5. Click the Sketch Ceiling icon 

6. Use the Line tool  and/or the Pick Lines tool  to sketch the ceiling plan in 
Figure 3.29 

7. In the Properties Palette, click the Edit Type button 
8. The Type Properties window will open, click the Duplicate button 
9. Accept the default name ‘GWB on Mtl. Stud 2’ by clicking OK 

10. Click the Edit button next to Structure 

11. On the 4th line, next to Gypsum Wall Board select the square box with 3 dots 

12. The Material Browser window will open, Click the Add Materials button  and 
click the Duplicate Selected Material option 

13. Rename the material ‘Gypsum Pattern’ 
14. Under the Graphics tab, find the Surface Pattern section 
15. In the subsection labeled Foreground, click the white box next to the pattern 

labeled <none> 
16. Scroll through the list of patterns and choose Sand – Dense 
17. Click OK to close all 4 windows 

18. On the ribbon, click the green checkmark  to complete the ceiling 

Figure 3.28 Adjusting the ceiling material properties 
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Figure 3.29 View of Level 4 ceiling in plan view and a 3D view looking from the bottom 
to the top 
(In the 3D view two walls have been hidden from view to better show the ceiling 
system) 

 

TIP 

If the ceiling is not visible in the Level 4 Ceiling plan view, go to the Properties 
Palette, under the Underlay section, change the Range: Base Level to Roof 

 
Floors, Roofs, and Ceilings Video Tutorial 
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Chapter 4: Stairs, Railings and 
Ramps 

Continue working on the same project file from the previous chapters. 

4.1 TYPES OF STAIRS 

Assembled 

Assembled stairs show each riser, tread, and stringer as separate elements like 
assembled wooden stairs. 

Figure 4.1 Assembled Stair 

Monolithic 

Monolithic stairs use the same material for treads, risers, and stringers. 
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Figure 4.2 Monolithic Stair 

Precast 

Precast stairs use structural rebar in concrete like a cast-in-place stair would be built 
on-site. 
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Figure 4.3 Precast Stair 

4.2 CREATE STAIRS 

Create a straight run stair by component 

1. Click the Architecture tab 

2. In the Level 1 view, click the Stair icon 
3. Use the Type Selector to choose the Assembled Stair 
4. On the Options Bar, change the Location Line to Exterior Support: Left 
5. Click to begin the stair as shown in Figure 4.4 
6. Drag the cursor till it shows 10 risers will be created and 9 risers are remaining 
7. Click to place the first 10 risers 
8. Drag the cursor up and place the remaining stairs 9-foot away 

9. Select the Railing icon  on the Ribbon 
10. Choose the Handrail – Rectangular option and click OK 

11. Use the Move tool  if needed to place the stairs in the bottom left corner of the 
shaft opening 

12. In Elevation or 3D view, select the stair and choose the Connect Levels icon 
from the Modify tab 

70  |  Chapter 4: Stairs, Railings and Ramps



13. Select the level lines 3 and 4 to connect to each other 

14. Click the green checkmark  to complete the stair 

Figure 4.4 Assembly stair in plan view and in 3D view 
(One wall in the 3D view is hidden to show the stairs connecting to multiple levels) 

Create a custom stair by sketching 

1. Open the Level 1 view from the Project Browser 
2. In the Properties Palette, in the Underlay section, change the Range: Base Level to 

Level 2 
3. Click the Architecture tab 

4. Click the Stair icon  on the ribbon, under the Circulation panel 

5. In the Properties Palette, select the Edit Type icon 
6. In the Type Properties window click the Duplicate button 
7. Change the name to “7in max riser 1ft tread” 
8. Change the following parameters 

◦ Maximum Riser Height: 0’ 6.9” 
◦ Minimum Tread Depth: 1’ 0” 

9. In the Components panel, click the Sketch tool 

10. Click the Boundary icon 

11. Following Figure 4.5, use the Line tool  to draw green boundary lines in the 
Level 1 floorplan 
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12. Click the Riser icon 

13. Following Figure 4.5, use the Line tool  and the Start-End-Radius tool  to draw 
risers 1 foot apart. 

14. Click the Stair Path 
15. Click to place a connected line from the top riser to the bottom riser 
16. Click the green checkmark  to complete the stair 
17. Look at the 3D view, if the stair direction is wrong, on the ribbon click the Flip icon 

18. On the ribbon, select the Railing icon 
19. The Railing window will open. Change the following parameters 

◦ Choose the Glass Panel – Bottom Fill 
◦ Choose the Stringer option 
◦ Click OK 

20. Click the green checkmark  to complete the stair 

Figure 4.5 Stair sketch in plan view and finished stair in 3D view 
(Two walls in the 3D view are hidden to show the custom stair) 

 

TIP 

The Offset tool is handy for creating repetitive lines 
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Create a Full-Step spiral stair 

1. Open the Level 3 floor plan view 
2. Click the Architecture tab 

3. Click the Stair icon  on the Ribbon, under the Circulation panel 
4. On the Options Bar change the Actual Run Width to 5’ 0” 
5. Use the Type Selector to choose the Assembled Stair 7” max riser 11” tread 
6. In the Properties Palette change the following parameters 

◦ Base Level: Level 3 
◦ Top Level: Level 4 

7. In the Components panel, click the spiral tool 
8. In the Level 3 view, click once on the canvas at the center of the 15-foot square 

opening and drag the cursor out as shown in Figure 4.6 to create a radius of 6’0″ 
9. Type 10” and press the Enter key 

10. Click the Landing icon 

11. Use the Line tool  to draw a landing to connect the stair to the floor plate as 
shown in Figure 4.6 

12. Click the green checkmark  to complete the Landing 

13. On the ribbon, select the Railing icon 
14. The Railing window will open, change the following parameters 

◦ Click the Glass Panel – Bottom Fill 
◦ Click the Stringer option 

15. Click the green checkmark  to complete the Stair 
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Figure 4.6 Spiral stair in plan view and in 3D view 
(The 3D view shown uses a section box to better view the added element. A section box 
can be added through the Properties Palette) 

Create a Center-Ends spiral stair 

1. In the Level 2 view, click the Architecture tab 

2. Select the Stair icon  from the ribbon, under the Circulation panel 
3. On the Option Bar change the Actual Run Width to 4’ 0” 

4. In the Components panel, click the Center-Ends Spiral tool 
5. Hover the cursor over the center edge of the mezzanine. When the midpoint snap 

appears (magenta triangle), click to start placing the stair 
6. Drag the cursor down the mezzanine edge to create a 6-foot radius. Click to begin 

placing the stair treads 
7. Drag the cursor up and around until 10 risers are created and 11 risers remain 
8. Click to finish placing the stairs 

9. Select the Center-Ends Spiral Tool again 
10. Select the center radius 
11. Drag the cursor out from the first 10 steps to create a 6-foot radius and an 

automatic curved landing is created 

12. In Elevation or 3D view, select the stair and choose the Connect Levels  icon 
from the Modify tab 

13. Select the level line 3 

14. Click the Railing icon 
15. Select Glass Panel – Bottom Fill 
16. Click OK 

17. Click the green checkmark  to complete this step 

74  |  Chapter 4: Stairs, Railings and Ramps



Figure 4.7 Spiral stair in plan view and in 3D view 
(Two walls in the 3D view are hidden to better show the custom spiral stair) 

4.3 TYPES OF RAILINGS 

Glass Panel 

Metal Railing with glass panels filling in the bottom area 
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Figure 4.8 Railing Glass Panel in 3D view 

Guardrail – Pipe 

The typical railing of several horizontal members that have no applied materials. 
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Figure 4.9 Railing Guardrail – Pipe in 3D view 

Guardrail – Rectangular 

The typical railing of several vertical members that have no applied materials. 
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Figure 4.10 Railing Guardrail – Rectangular 

Handrail – Pipe 

The typical railing of several horizontal members that have no applied materials. 
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Figure 4.11 Railing Handrail – Pipe 

Handrail – Rectangular 

The typical railing of several vertical members that have no applied materials. 
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Figure 4.12 Railing Handrail – Rectangular 

4.4 CREATE RAILINGS 

Create railings using the Line Tool 

1. In the Level 2 view, click the Architecture tab 

2. Click the Railing icon drop-down menu from the Circulation Panel 
3. Use the Type Selector to choose the Glass Panel – Bottom Fill 

4. Select the Line tool 
5. Follow Figure 4.13 to draw the first railing in magenta 0’4″ from the edge of the 

mezzanine 

6. Click the green checkmark  to complete the railing 
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Figure 4.13 Level 2 sketched railings shown in plan view 
7. Each railing must be continuous therefore follow the same steps to complete rails 

2 and 3 highlighted in yellow in Figure 4.13 

8. Click the green checkmark  to complete the railing 
9. Continue to draw the railings for Levels 3 and 4 shown in Figure 4.14 
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Figure 4.14 Mezzanine railing completed for Levels 2, 3, and 4 
(Two walls in the 3D view are hidden to show the railings) 

Modify a railing 

1. In the 3D view, click the View Cube on the top corner between the Left and Front 
face 

2. Select the two connecting walls in this view 
3. Right-click and click Hide in View 
4. In the sub-menu click Element 
5. Hold down the Control key and select all of the railings in the Shaft Opening 
6. Use the Type Selector to choose Handrail – Rectangular 

7. Click the Edit Type button 
8. Click the Duplicate button 
9. Accept the default name change 

10. Under the Top Rail section, by Type, select the words “Rectangular 2X2” then click 
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the 3 dots button 
11. Under the Extension Beginning/Bottom set the following parameters 

◦ Extension Style: Wall 
◦ Length: 1’ 0” 
◦ Click OK 

12. Under the Handrail 1 section, by Type, select the word “<none>” then click the 3 

dots button  that appears 
13. Under the Extension Beginning/Bottom change the following parameters 

◦ Extension Style: Post 
◦ Length: 1’ 0” 
◦ Check the box next to Plus Tread Depth 
◦ Click OK 

14. Under Handrail 1, change the position to Left 
15. Click OK 

Figure 4.15 Handrail added to the inside of the existing railing 
(One wall in the 3D view is hidden to show the stairs and handrailing) 
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4.5 RAMPS 

Create a ramp using the Line Tool 

1. In the Level 2 view, click the Architecture tab 

2. Click the Ramp icon on the ribbon 

3. In the Properties palette, click the Edit Type button 
4. Duplicate the type and change the name to “My Ramp” 
5. Change the Maximum Incline Length to 33’ ¼” 
6. Click OK to accept the changes 

7. Use the Line tool  to begin drawing the first incline of the ramp as shown in 
Figure 4.16 

8. Pull the cursor away from the first incline to provide a landing as shown in Figure 
4.16 

9. Complete until there is 0” remaining of the ramp to place 
10. Click the green checkmark  to complete the ramp 
11. After the ramp is created select the Level 2 floor plate and edit the boundary to 

include an opening for the ramp to reach level 3 

Figure 4.16 Ramp shown in plan view and in 3D view 
(One wall in the 3D view is hidden to show the inner railing) 

Modify a ramp 

1. In the Level 2 view, select the ramp 

2. Click the Edit profile icon 
3. Working from right to left, select a line 
4. Use the witness lines to change dimensions as shown in Figure 4.17 
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Figure 4.17 Ramp dimensions modified and shown in plan view 
5. Use the Pin tool  to lock the lines in place once the dimensions are corrected 

6. Click the green checkmark  to complete the ramp 
7. Select the ramp 

8. Click the Edit Type button 
9. Under construction, next to Shape, click the drop-down menu 

10. Choose Solid 

11. Use the Move tool  to move the ramp into the corner as shown in Figure 4.18 
12. Select the railings 
13. Use the type selector to choose Handrail – Pipe 
14. Select and modify the Level 3 floor around the ramp 

Figure 4.18 Completed ram shown in 3D view with 2 walls hidden 
 

TIP 
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Select the perpendicular line to the left of the line you want to adjust 

Stairs, Railings and Ramps Video Tutorial 
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Chapter 5: Adding - Modifying 
Families 

Families are typically small-scale elements where most files are set with given 
parameters. Parameters are used to define the extent of an element. For example, 
a family of windows may have parameters that define the sizes available per a 
manufacturer’s catalog such as 2ft X 2ft, 2ft X 4ft, 3ft X 4ft, and 3ft X 5ft. 

Revit provides several generic families of doors, windows, casework, furniture, and 
more. A user can easily create custom families or downloaded files from the internet. 

A custom family file uses templates to define an elements category. Once a template 
is chosen it cannot be changed later. The file will have to be recreated in a new template 
because the copy-paste function does not work between families. 

Element-based – A family created using an element-based template such as “floor-
based” or “wall-based” can only be placed on that element within a project. 

Adaptive – A family created where the parameters are much more flexible and can 
conform to any project’s unique geometries, however, the 2D annotation options are 
disabled (Text, symbols, detail components, etc). 

5.1 PLACE FAMILY ELEMENTS 

Through the Project Browser 

Refer to Chapter 1, section 1.4 on Project Browser, Place family elements 

Through the Ribbon 

1. Click the Architecture ta 

2. Click the Component icon 
3. Click Place a Component 

4. On the ribbon, click the Load Family icon 
5. The Load Family window will appear, open the Furniture folder 
6. Open the Seating folder 
7. Choose the Sofa-Corbu 
8. Click Open 
9. Click the canvas to place the sofa 
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10. Explore the folders and place a few more elements 
11. Use the Type Selector to choose a different element such as the Desk. 
12. Save and close this project 

TIP 

Use the Space bar to rotate the position of the element 

 

5.2 CREATE A FAMILY FROM TEMPLATE 

Create a Profile file 

1. Click the File tab 
2. Click the side arrow to access the New sub-menu 
3. Choose to begin a new Family 
4. In the New Family – Template File, choose the Profile.RFT file 
5. Click the File tab 
6. Click the Save As option 
7. Choose to save as a Family 
8. Save in a folder that is memorable 
9. Name the family “Elaborate Table Leg Profile” 

10. In the Draw panel, use the Line tool  and Start-End-Radius arc tool  to draw 
the profile shown in Figure 5.1 
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Figure 5.1 Profile shape and dimensions in 2D 

Open a Family Template 

1. Click the File tab 
2. Click the side arrow to access the New sub-menu 
3. Choose to begin a new Family 
4. In the New Family – Template File, choose the Furniture.RFT file 
5. Click the File tab 
6. Click the Save As option 
7. Choose to save as a Family 
8. Save in a folder that is memorable 
9. Name the family “Elaborate Dining Table” 

5.3 ADD REFERENCE PLANES AND SET 
PARAMETERS 

Reference planes have two uses: one is used as guidelines or constructions to align 
elements to a specific position and the second use is to control the form or position of 
geometries. Constraints are used on geometries to bound them to reference planes, 
selected dimensions, or alignments. 

In this example the tables’ geometries will be aligned to placed reference planes then 
constraints are set to lock the table’s dimensions to set sizes. 

Placing Reference Planes 

1. First, set up the user interface to view all 4 windows, In the View tab, click the Tile 

Views icon 
2. In the Ref. Level view, go to the Create tab on the Ribbon then click on the 

Reference Plane icon 
3. Draw a vertical line on one side of the center reference plane and use the Mirror 

icon  to create another 
4. Select each reference plane and rename them Left and Right respectively 
5. Use the witness lines to change the distance to the center reference plane to 3’0” 

as shown in Figure 
5.2 
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Figure 5.2 Vertical reference planes created and labeled 
6. Create one horizontal line on the left side of the center reference plane then use 

the Mirror icon  to create another 
7. Label them Top and Bottom respectively 
8. Use the witness lines to change the distance to the center reference plane to 1’6” 

as shown in Figure 5.3 

Figure 5.3 Horizontal reference planes created and labeled 

Setting Constraints 

9. Under the Modify tab, use the Aligned Dimension icon to place dimension strings 
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connecting the Left-Center-Right and another connecting Left-Right as shown in 
Figure 5.4 (left). Do the same for Top-Center-Bottom and Top-Bottom as shown in 
Figure 5.4 (left) 

10. Select the 3’ 0” dimension string and enable equal dimensions by clicking on the 
EQ  as shown in Figure 5.4 (right). Do the same for the 1’ 6” dimension string. 

Figure 5.4 (left) Dimension strings placed and (right) enabled EQ for 3’0” and 1’6” 
dimension strings 

11. Select the 6’0″ dimension string 

12. On the Ribbon under the Architecture tab, click the Create Parameter icon 
13. In the Parameter Properties window change the following information 

◦ Name the parameter Length 
◦ Select the Type option 
◦ Click on the Edit Tooltip and add a description 
◦ Click OK 

14. Complete the same instructions for the 3-foot dimension 

Flexing Constraints 

“Flexing” constraints are used to test if the dimension strings act accordingly to the 
applied changes. To flex a model, the Family Type icon is used. For this example, 
assume the manufacturer of the dining table wants to offer three lengths for 
different household sizes. The 6-foot table sits 4 people, the 7-ft table sits 6 people, 
and the 8-ft table sits 8 people. 

15. On the ribbon, click the Family Type icon  to flex the model. 
16. Change the Length to 7 feet and click Apply. If the reference planes are set 

correctly the model will reflect the changed length in the Ref. Level view. 

92  |  Chapter 5: Adding - Modifying Families



17. Change the Length back to 6 feet 

Creating New Parameters 

The New Parameter icon is used to create the available lengths of tables offered by 
the manufacturer. The table geometries will respond to the new parameters. When 
a Revit user uploads this table family into a project, they can choose which length 
of the table is appropriate for their client. 

18. In the Family Type window click the New Parameter icon 
19. Name the type 6-foot table and click OK 
20. Click Apply 
21. Use the New Type icon to create a 7-foot and click OK 
22. Change the length to 7’0” 
23. Click Apply 
24. Click the New Type icon and create an 8-foot table 
25. Change the Type to 6 feet and click OK to close to the Family Type window 

26. In the Front view, create the following reference planes  that will determine the 
top and bottom of the tabletop height then rename them accordingly 

◦ Top of Table at 3’ 0” 
◦ Bottom of Table at 2’ 9” 

27. Lock both lines using the Pin Tool 

Figure 5.5 Reference planes drawn in the Front view 
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5.4 CREATE A SOLID FORM 

1. In the Front view under the Create tab, click the Set icon  on the Ribbon 
2. Select the Name option 
3. In the drop-down menu choose Reference Plane: Bottom of Table and select OK 

4. Under the Create tab, click the Extrusion icon 
5. In the Properties Palette, change the following parameters 

◦ Extrusion End: 0’ 3” 
◦ Extrusion Start: 0’ 0” 

6. Use the Rectangle tool to draw a 3’X6’ extrusion along the reference planes 

7. Click the green  checkmark to complete the extrusion 
8. To lock the rectangle geometry to the reference plane go to the Modify tab and 

select the Align tool 

◦ In the Ref. Level view, select the top edge of the table 
◦ Then select the reference plane that the edge lies on. 
◦ An open lock will appear, click on it to lock the edge of the table to that 

reference plane. 
◦ Do this to each edge of the tabletop rectangle. 

9. In View 1, on the View Control Bar, use the Visual Style icon to choose the Shaded 
 selection 

Figure 5.6 Tabletop solid extrusion 
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Create a Sweep Form by Load Profile 

1. Create a second set of reference lines following Figure 5.7 
2. Label the line like the following respectively 

◦ Top 1, Top 2, Bottom 1, Bottom 2, Left 1, Left 2, Right 1, and Right 2. 

3. Under the Modify tab, use the Aligned Dimensions icon  to add dimensions as 
shown in Figure 5.7 

4. Select each of the highlighted dimensions individually (as shown in Figure 5.7) and 

click the unlock symbol to Lock it 

Figure 5.7 Highlighted dimensions shown are locked 

5. Under the Create tab, click the Sweep icon  

6. Click the Sketch Path icon 

7. Use the circle tool  to create a circle with a 1/4” radius in between the two 5″ 
reference lines in the top right corner of the tabletop 

8. Click the green  checkmark to complete the path 

9. On the Ribbon under the Modify tab, click Load Profile 
10. Navigate to select the Table Leg Profile created previously 
11. Click Open 
12. On the Ribbon in the Sweep panel, use the drop-down menu by Profile to choose 

the Table Leg Profile. 

13. Click the green  checkmark to complete the Profile 
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TIP 

If the profile will not complete due to an error, use trim/extend tool  to 
connect the lines so geometries do not fold in on itself 

Edit Work Plane if the leg is not in the right place 

14. Select the Leg 

15. Use the Mirror – Pick Axis tool  to create a second leg 
16. Select the two first legs 

17. Use the Mirror – Pick Axis tool to create the last two legs 
18. Check the Flex using the Family Types icon 

Figure 5.8 Table leg profile sweep applied and mirrored 

Create a Sweep Form by Sketch 

1. Under the Create tab, click the Set icon  on the Ribbon 
2. Select the Name option 
3. Choose Reference Plane: Top of Table then select OK 
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4. Under the Create tab, click the Sweep icon 

5. Click the Sketch Path icon 
6. In the Ref. Level view, use the rectangle tool  to outline the table 

7. Click the green  checkmark to complete the path 

8. On the ribbon, click the Select Profile 

9. Click the Edit Profile icon 
10. In the Right view, draw the profile like the one shown in Figure 5.9 

Figure 5.9 Table edge sketch sweep 

5.5 CREATE A VOID FORM EXTRUSION 

1. Use the Set icon  to choose the Reference Plane: Top of Table 
2. In the Reference Level view, go to the Create tab 

3. Click the Void forms drop-down menu then click the Void Extrusion icon 
4. On the Options Bar, change the depth to 1″ and the offset to 2” 

5. Select the Pick Line tool  from the Draw panel 
6. Hover the cursor over the reference lines at the edge of the tabletop until the light 

blue dashed line appears facing towards the tabletop’s interior. Use Figure 5.10 as a 
reference. Do this for all 4 edges. 
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Figure 5.10 Reveal created using a void extrusion 

7. Use the Trim/Extend tool  to trim the rectangle 

8. Use the Offset tool  at 1” to create a second rectangle within the first 

9. Use the Trim/Extend tool  to trim the second rectangle 

10. Click the green checkmark to complete the void extrusion 
11. Select the void 
12. In the Properties Palette, change the Extrusion Start to -0’ 1” 
13. Click Apply 

TIP 

Follow the below steps if the void does not automatically cut into the 
tabletop. – Under the modify tab select the Cut icon. Select the void extrusion 
then select the tabletop. 
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5.6 MATERIALS 

Create a new Material using the Asset Library 

1. In the 3D view, select the first tabletop extrusion 
2. In the Properties Palette, next to Material, click the 3 dots button 
3. Select the Default material 

4. Click the Materials Icon 
5. Click the Duplicate Selected Material 
6. Change the name to Wooden Finish 

7. With the Wooden Finish selected, click the Asset Library icon 
8. In the Asset Browser, expand Appearance Library 
9. Click Wood 

10. Use the search bar or scroll down to find Mahogany – Stained Dark Polished 

11. Use the Replace Asset icon  to apply the material 

12. Click the Asset Library icon  again to close the Asset Browser window 
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Figure 5.11 Material and Asset Browser window 
13. Click the Image box 
14. In the Texture Editor, change the Rotation to 90 degrees 
15. Click Done to accept the changes 
16. Click Apply and OK in the Material Browser window 
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Figure 5.12 Material Browser and Texture Editor windows 
17. In the 3D view, use the Visual Style icon to change the appearance to Realistic 
18. Follow the same steps to apply the Mahogany – Stained Dark Polished material to 

the rest of the table elements 
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Figure 5.13 Mahogany material applied to the tabletop extrusion 

Figure 5.14 Completed table with Mahogany material applied to all elements 

5.7 Nested Family 

1. Start a New Family using the Generic Model template 
2. Follow Figure 5.11 to create an 8” X 16” oval plate and an apple using the spline tool 

102  |  Chapter 5: Adding - Modifying Families



Figure 5.15 Solid extrusion with an applied marble material 
3. Change the Material to a Stone Marble finish 
4. Follow Figure 5.16 to create an apple on top of the marble Plate 
5. Use the Red Paint from the Asset Library 

Figure 5.16 Sweep extrusion – apple 
6. Go to File and Save As a family 
7. Label the project Table Decoration 

TIP 

Chapter 5: Adding - Modifying Families  |  103

www.dbooks.org

https://www.dbooks.org/


It is easiest to have the Project, Elaborate Dining Table, and Table 
Decoration file open at the same time 

 

8. In the Table Decoration project, click the Load into Project icon  under the 
Create tab 

9. Deselect the Project file and select the Dining Table file 
10. Click OK 
11. Close the Table Decoration windows 
12. In the Ref. View of the Dining Table project, click the Create tab 

13. Click the Component icon 
14. Use the Type Selector to choose the Table Decoration 
15. In the Properties Palette change the Offset to 3’0” 
16. Click to place the decoration on the table 

Figure 5.17 Table Decoration is Nested within the Dining Table file 
17. Load Family into a Project 
18. In the Dining Table project, click the View tab 

19. Click the Load into Project icon 
20. Place an 8-foot, 7-foot, and 6-foot table on the second floor of the building 
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Figure 5.18 Placed Elaborate table families 

Families Video Tutorial 
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Chapter 6: Massing - Conceptual 
Mass 

Massing can be used to build anything from small elements to an entire building’s 
masses. In this chapter, start a new project using the Architectural template. Save the 
new project as “Class Project 2”. 

6.1 TYPES OF MASSING 

In-Place Mass 

An In-Place Mass is located on the ribbon under the Massing & Site tab by selecting the 
In-Place Mass icon. This massing is used to create large-scale building masses where 
floors, walls and roofs can be added quickly. The items created in a project through this 
method are only available in this project and will not be saved as an individual family 
file. 

Model In-Place 

The model in-place is located on the ribbon under the Architecture tab by accessing 
the Component icons drop-down menu. This massing is used to build a small-scale 
element that is specific to the project such as countertops shapes, wall details, or 
shading systems, where the project’s geometries are available to build from. The items 
created in a project through this method are only available in this project and will not 
be saved as an individual family file. 

Conceptual Mass 

A conceptual mass can be created by navigating through the File tab, New sub-menu, 
and selecting Conceptual Mass. When working in a conceptual mass file, the project 
does not contain other project geometries to work from. A Conceptual Mass file is 
different than a Family file because massing can be quickly modeled, there is not a 
list of categorized model types to choose from and it is typically used for large-scale 
massing. This massing is saved as separate files and can be loaded into any project. 
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6.2 CREATE IN-PLACE MASS 

1. Open a New, Architectural template project 
2. Save the project as “Class Project 2” 

3. Open the 3D view by clicking the Default 3D View 
4. Open the North Elevation from the Product Browser 

5. On the ribbon, under the Architecture tab, click the Level Icon 
6. Place 3 levels at 20ft, 30ft, 40ft, and 50ft from the ground plane 
7. Close the North Elevation 

8. Under the View tab, click the Tile Views icon 
9. Click the Massing & Site tab 

10. Click the In-Place Mass icon 
11. Name the mass Main Building 
12. Click OK 

13. On the ribbon, click the Model icon 

14. Use the Line tool  to draw a 60ft X 60ft square as shown in Figure 6.1 
15. Select the square 

16. On the ribbon, click the Create Forms  drop-down menu and choose the Solid 

Form  option 
17. In the 3D view, select the top face of the cube and use the witness lines to adjust 

the height to 20’0” as shown in Figure 6.1 

Figure 6.1 Massing dimensions shown in the Level 5 plan and the North elevation 
view 

18. Repeat steps 13 through 16 until all three masses have been created as shown in 
Figure 6.2 

19. Click the green checkmark to finish the mass 
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Figure 6.2 Completed massing shown in 3D view 

TIP 

Use the Green, Blue and Reg toggle tool  to move the faces up and 
down 

 

Apply Floors, Walls, and a Roof by Face to an In-Place mass 

1. In the 3D view, select the mass 
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2. On the ribbon, click Mass floors 
3. In the window click to check the box next to Level 1, 2, 3, 4, and 5. 
4. Click to open the architecture tab 

5. Click the Floor icon  drop-down menu and click the Floor by face  option 
6. Use the Type Selector to change the type to 3” LW Concrete on 2” Metal Deck 
7. Click on each floor plane which will turn blue after selected 

8. On the ribbon, click the Create Floor  Icon 

Figure 6.3 Created floors shown in the North elevation and in 3D view 

9. On the Architecture tab, click the Wall icon  drop-down menu to choose the 

Wall By Face  option 
10. Use the Type Selector to change the type to Exterior – EIFS on Metal stud 
11. As each wall is selected in the 3D view, the plane becomes a thickened wall 

12. Click the Modify icon  to exit the command 

Figure 6.4 Created walls shown in the Level 5 plan view and 3D view 

13. On the Architecture tab, click the Roof icon  drop-down menu to choose the 

Roof by Face  option 
14. Use the Type Selector to change the type to Steel Truss – Insulation on Metal Deck 

– EPDM 
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15. In the 3D view, click the top plane which will turn blue after selected 

16. On the ribbon, click the Create Roof Icon 
17. Select all four walls by holding the Control key down 

18. On the ribbon, click the Attach Top/Base Icon 
19. Select the roofs 

Figure 6.5 Created flat roof shown in the Level 5 view and in 3D view 

6.3 CREATE A CONCEPTUAL MASS 

1. Click the File tab 
2. Click the New sub-menu arrow and choose the Conceptual Mass option 
3. Select the Mass.RFT file 
4. Save the project as Conceptual Mass 
5. Open the Level 1 view 
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6. Use the Line tool  to draw the shape shown in Figure 6.6 
7. Select the shape 

8. On the ribbon, click the Create Forms  drop-down menu and choose the Solid 

Form  option 
9. Select the rounded edge along the top face of the mass 

10. At the center of the Toggle tool , click the black circle and drag the edges 
inward a short distance 

Figure 6.6 Conceptual mass shown with dimensions in plan view and in 3D view 

11. On the ribbon, click the Load in Project and Close  icon 

12. Make sure the Place on Workplace  is selected 
13. Place the mass by the building 

14. Use the Move tool  to connect the Conceptual Mass to the Mass Building as 
shown in Figure 6.7 

Figure 6.7 Connected masses shown in the Level 1 view and in 3D view 
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Apply a Curtain wall to a conceptual mass 

1. Click the Architectural tab 

2. Click the Curtain System icon 
3. Select the tilted curved wall 
4. In the Properties Palette click the Edit Type button 
5. Click the Duplicate button 
6. Change the name to 2’ X 5’ and click OK 
7. Change the following parameters 

◦ Curtain Panel: System Panel: Glazed 
◦ Grid 1: 

▪ Layout: Maximum Spacing 
▪ Spacing: 2’ 0” 
▪ Check the box by Adjust for Mullion Size 

◦ Grid 2: 

▪ Layout: Maximum Spacing 
▪ Spacing: 5’ 0” 
▪ Check the box by Adjust for Mullion Size 

8. Click OK 

9. Click the Create System icon  

10. On the Architecture tab, click the Mullion icon  

11. Click the All Grid Lines icon 
12. Use the Type Selector to choose the 1.5” X 2.5” rectangular 
13. Select the curtain wall 

14. Add a roof by using the Roof by Face icon 

112  |  Chapter 6: Massing - Conceptual Mass



Figure 6.8 Conceptual Mass with applied curtain wall in 3D view 

Massing Video Tutorial 
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Chapter 7: Model In-Place 

Open and work in the same project file from Chapters 1 through 5 

7.1 MODEL IN-PLACE 

Parametric Bench 

1. Open the Level 4 view from the Project Browser 
2. Click on the View tab 

3. Click on the Section icon 
4. Click on the West side of the building to start the section cut then drag the cursor 

over and click to finish the section cut on the East side of the building as shown in 
Figure 7.1 

5. Place another section cut from the Northside to the Southside 

Figure 7.1 Section cuts shown in the Level 4 plan view 
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6. Click on the Architecture tab 

7. Click the Component icon  drop-down arrow 

8. Click the Model In-Place icon 
9. In the Family Category and Parameter window, select the Furniture option and 

click OK 
10. Name the mass “Bench” and click OK 

11. In the Create tab on the Ribbon, click the Sweep Blend Icon 

12. Click the Sketch Path icon 

13. From the Draw panel choose the Center-Ends Arc  and begin by drawing a 10’ 
radius then drag the mouse out to draw a 90-degree angle as shown in Figure 7.2 

Figure 7.2 Sweep blend path drawn with the Center-Ends Arc tool 

14. Click the green  checkmark to finish sketching the path 

15. Click the Select Profile 1 icon  on the ribbon 

16. Click the Edit Path icon 
17. In the Go to View window choose the South Elevation and click Open View 

18. Use the Line tool  and Spline tool T to draw a chair-like outline as shown in 
Figure 7.3 
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Figure 7.3 Curvilinear chair outline shown in elevation 

19. Click the green  checkmark to complete profile 1 

20. Click the Select Profile 2 icon  on the ribbon 

21. Click the Edit Path icon 
22. In the Go to View window choose the East Elevation and click Open View 

23. Use the Line tool  and Spline tool  to draw a stool-like outline as shown in 
Figure 7.4 
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Figure 7.4 Curvilinear stool outline shown in elevation 

24. Click the green  checkmark to complete profile 2 
25. In the 3D view select the bench 
26. In the Properties Palette next to <By Category> click the 3 dot icon 
27. Select the default material Wood – Stained and click OK 

28. In the Level 4 view go to the Create tab and click the Void Form icon  drop-
down menu 

29. Click the Void Extrusion option 

30. Use the Line tool  to draw a 1” X 4’0” rectangle that cuts through the bench 
31. On the Options Bar change the depth to 4’0″ 

32. Click the green  checkmark to finish the extrusion 

33. Under the Create tab, click on the Model Line icon 
34. Draw two lines from the ends of the bench to the center radius as shown in Figure 

7.5 
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Figure 7.5 Bench shown in plan view with the first extrusion cut and model lines 
35. Check an elevation view that the extrusion cuts through the whole sweep 
36. In the Level 4 view select the void 

37. Under the Create tab in the Modify panel, select the Array tool 
38. Click and drag the blue circle at the center of the void to the intersection of the 

model lines as shown in Figure 7.6 
39. On the Options Bar change the following items 

◦ Select the Radial icon 
◦ Change the Number to 30 
◦ Select the option Move to: Last 

40. Click once on the lower model line and drag up to the second model line which 
will create a 90-degree array 
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7.6 (left) First void extrusion and (right) void extrusion array 
41. Once all the voids have been placed click the green  checkmark to finish the 

Bench mass 

TIP 

If the array spreads past 90 degrees click and drag the blue circle at the 
obtuse end back to 90 degrees 

If the voids are orange then they have not cut the form. In the Modify tab, 
select the Cut icon from the Geometry panel. Click the void first then the 
bench form 
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Figure 7.7 Completed Parametric Bench 

7.2 In-Place Model 

Wall with 3D Geometric Pattern 

1. Open the 3D view, Level 4 View, and Section 2 view. If any other views are open, 
close them out. 

2. Type WT to tile the windows and ZA to zoom all the windows 
3. Click the Architecture tab 

4. Click on the Wall icon 
5. Choose the Type Selector to choose the 4 7/8” Interior Partition Wall 
6. Change the Top Constraint to Unconnected with a Height of 8’0” 
7. Draw an 8-ft wall 
8. In the Section 2 view, click on the Annotate tab 

9. Click on the Detail Lines icon 

10. In the East view, draw the pattern as shown in Figure 7.8 with the Line tool 

TIP 

120  |  Chapter 7: Model In-Place



These detail lines will not show up in the 3D view because detail lines are 
specific to the plan or elevation it is drawn in 

Figure 7.8 Detail line annotation pattern shown in the Section 2 view 
 

11. In the Level 4 view click on the Massing & Site 

12. Click the In-Place Mass icon 
13. Name the mass 3D Pattern Wall and click OK 

14. In the Level 4 view, click the Plane icon  on the Ribbon 
15. Draw a line across the East facing wall and change the name to Ref 1 
16. Draw a second line 6” from the first and change the name to Ref 2 (See Figure 7.9) 

17. In the East view, select the Reference icon 

18. Select the Point Element tool  as shown in Figure 7.9 

19. Select the Draw on Work Plane icon 
20. On the Option Bar, change the Placement plane to Reference Plane: Ref 1 
21. Place an element point at the corners of each square as shown in Figure 7.9 
22. On the Option Bar, change the Placement plane to Reference Plane: 2 
23. Place an element point at the center intersection of each square as shown in 

Figure 7.9 
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Figure 7.9 (top left) shows point elements on Ref1 and Ref2 and (right) shows 
points in Section 2 view 

24. In the 3D view, click the create tab 

25. Click the Reference icon 

26. Click the Line tool 
27. On the Option Bar make sure 3D Snapping and Chain are checked 
28. In the Section 2 view, draw a line from dot to dot. Be sure to watch the 3D view in 

case the line does not snap to the element points. Once the entire wall is complete 
as shown in Figure 7.10, proceed to the next step 

Figure 7.10 Connected reference lines shown in Level 4 view, 3D view and Section 2 
view 
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TIP 

It may help to draw the horizontal and vertical lines from the first edge to 
the opposite edge of the wall. Second, draw the diagonal lines within each 
square individually. This helps the system snap to the intersections 

 

29. In the 3D view, click the Modify tool  from the Ribbon 
30. While holding down the Control key, select 3 reference lines that create a triangle 

as shown in Figure 7.11 

Figure 7.11 (left) Three selected reference planes used to create a solid form and 
(right) options to create a solid 

31. On the ribbon, click the Create Form  drop-down arrow and click the Solid 

Form 
32. Two images will pop-up, click the 2D (flat) image on the right as shown in Figure 

7.11 
33. Repeat steps 29 through 32 until the entire wall has been created. 
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TIP 

If a line is missing, follow steps 25 through 28 to place it, then continue 
moving forward 

 
34. Once the previous step has been completed for the entire wall, click the green 

checkmark to finish the mass as shown in Figure 7.12 

Figure 7.12 Completed creation into solid forms 

Creating Wall Types for the 3D Pattern Wall 

35. Click the Architecture tab 
36. Use the Type Selector to choose the Generic 5” 
37. Click the Edit Type button 
38. Duplicate and change the name to Bronze Wall 
39. Click the Edit button next to Structure 
40. Change the thickness to 1” 
41. Click the 3-dot icon  next under Material 

42. Click the Create Material icon 
43. Click the option to Create a new material 
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44. Rename the material Bronze Wall 

45. Click the Asset Library icon 
46. Expand the Appearance Library 
47. Expand the Metal section 
48. Click the Bronze option 

49. Next to the Bronze Polished click the Replace Asset icon 
50. Click Apply and OK 
51. Click OK to close the Edit Assembly and the Type Properties 
52. Create two more wall types with the following parameters 

◦ Wall 2: Grey Wall, 1” thick, Fabric – Fabric (Grey) 
◦ Wall 3: White Wall, 1” thick, Paint – White 

53. On the Architecture tab, click the Wall icon  drop-down arrow and click the Wall 

By Face icon 
54. Use the Type Selector to choose the Bronze Wall 
55. Click 1 triangle from each square at random to apply the Bronze Wall by face 
56. Change to the Grey Wall and select one triangle at random to add a wall 
57. Change to the White Wall and do the same for the remaining triangles 
58. ess ESC twice to exit the command 

TIP 

If the triangular wall does not line up correctly first click the edit profile 
icon. Hold the Control key down and select two of the lines. A blue circle will 
appear, click and drag this blue circle until it snaps into position. Click the 
green arrow to finish the profile. Do the same for the wall. 

Figure 7.13 Steps 1 through 3 to fix Wall by Face errors 
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Figure 7.14 Completed 3D Wall 

Curvilinear Façade 

1. Under the Massing & Site tab click the In-Place icon 
2. Name the mass Curvilinear Façade and click OK 
3. Open the Level 1 view 

4. On the ribbon click the Plane icon 
5. Draw 5 reference planes as shown in Figure 7.15 
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Figure 7.15 Reference planes shown in Level 1 view 
6. Change the reference plane names to 1, 2, 3, 4, and 5 respectively from left to right 

7. In the East view, select the Model icon 
8. On the Option Bar change the Placement Plane to Reference Plane: 1 

9. Use the Line tool  and Spline tool  to draw the profile shown in Figure 7.16 
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Figure 7.16 Profile drawn on Reference plane: 1 shown in the East view 
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10. Continue steps 7 through 10 to draw 4 more profiles on reference planes 2, 3, 4 and 
5 as shown in Figure 7.17 

TIP 

Make sure the profiles are drawn with different depths but are not too 
complex. Overly complex shapes cause geometries to fold in on themselves 
and will result in an error 

 

Figure 7.17 All reference planes are shown in the East view and 3D view 
11. In the 3D view select all 5 profiles by holding down the Control key 

12. On the Ribbon click the Create Form  drop-down and choose the Solid Form 

icon 
13. Select the exterior face of the wall behind the mass solid 

14. In the Modify tab select the Set icon 
15. Select the exterior face of the wall behind the mass solid 

16. In the Level 1 view, choose the Model icon 
17. Click the rectangle tool  and draw a box around each window 
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18. Select one of the rectangles 

19. On the ribbon click the Create Form  drop-down and choose the Void Form 

icon 
20. Use the green gumball arrow and pull it towards the exterior of the building to cut 

through the façade. See Figure 7.18 

Figure 7.18 Void extrusion shown cutting through the mass solid 

21. Click the green checkmark  to finish the mass 
22. Under the Architecture tab, click on the wall icon drop-down menu and select the 

Wall By Face icon 
23. Apply a Generic – 6” Masonry wall to all the sides of the mass. 
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Figure 7.19 Completed Curvilinear façade shown in 3D view 

 
Parametric Bench and Façade Video Tutorial 
3D Wall Video Tutorial 
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Chapter 8: Schematic Design 
and Room & Color Fill Plans 

 8.1 SCHEMATIC DESIGN 

Import a CAD file 

1. In the Level 1 view, click the Insert tab 

2. Click the Link CAD icon 
3. Locate the folder and select the file 
4. At the bottom of the window make sure Current View only is checked 
5. Use the Positioning drop-down menu to select Manual – Origin 
6. Click Open 

7. Use the Measure tool  and Scale  if necessary 

8. With the drawing selected click the Lock button 

TIP 

It is easiest to use a straight staircase as a reference given the tread 
measurements are universally about 1 foot deep. 
Add the separate plan files to their Revit level respectively 

Insert a 2D image 

1. Under the Insert tab click the Insert Image icon
2. Locate the folder, select the file, and click open 
3. The dashed X represents the image boundary, click anywhere on the canvas to 

place it 

4. Use the Measure tool  and Scale  if necessary 

5. With the drawing selected click the Lock button 
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Importing a 3D 

3D models can be imported into Revit from Sketch-up and FormIt, but they are 
imported in as a Family file that acts as guidelines to create a mass as covered in 
Chapters 6 and 7. 

8.2 ROOM AND COLOR FILL 

Set room computations 

1. In the Level 1 view, click the Architecture tab 
2. Click the Room and Area panels drop-down arrow 
3. Click the Area and Volume Computation 
4. In the window, select the Areas Only and At wall finish options 
5. Click OK 

Figure 8.1 Area and Volume Computation window 
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Place a room individually 

1. In the Level 1 view, click the Architecture tab 

2. Under the Rooms & Area panel, click the Room icon 

3. On the ribbon, make sure that the Tag on Placement icon    is highlighted in 
blue. Click to active and un-active the icon. Hover over a room to see the 
difference. 

4. Click to place a room as shown in Figure 8.2 

Figure 8.2 Placed room tag shown in the Level 1 view 
5. Hover the cursor over the room tag and select the X 
6. In the Properties Palette change the Number to 101 and the Name to Office as 

shown in Figure 8.2 

TIP 

Changes can also be made by Double-clicking on the text box 

Add and modify Separation Lines 

1. Click the architecture tab on the ribbon 

2. Click the Room Separation icon 
3. Draw the lines to create separate spaces as shown in Figure 8.3 
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Figure 8.3 Separation Lines indicated by the pink lines 

4. Under the Manage tab, click the Additional settings  drop-down menu and 

select the Line Styles option 
5. Expand the Lines Category by click the + sign 
6. Next to the <Room Separation>, click the Line Color box 
7. Change the color to White and click OK 

TIP 

Line styles are also used to modify model lines and detail lines 
throughout the project 

Create a schedule to place rooms 

1. Click the View tab 

2. Click the Schedules icon 

3. Click the Schedules/Quantities icon 
4. In the New Schedule window, scroll down the Category list and select the Rooms 

option 
5. Click OK 
6. In the Available fields, separately select Number, Name, and Area and click the 

Add Parameter button INSERT. 
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TIP 

The order in which parameters are added dictates how the columns are
set up in the schedule. It is important to add the parameters in order from 
top to bottom to how the schedule is referenced from left to right 

 
7. Click OK 
8. On the ribbon, click the Insert Data Row until 23 rows 
9. For the numbers 101 through 108, select the Room box and use the drop-down to 

select Office 
10. For the numbers 109, double-click the Room box and type Cubicle 
11. For the numbers 110 through 116, use the drop-down to select Cubicle 
12. Following the steps # through # change the name for the following numbers as 

shown in Figure 8.4 

◦ 117: Hall 
◦ 118: Hall 
◦ 119: Conference 
◦ 120: Conference 
◦ 121: Conference 
◦ 122: Open Work Space 
◦ 123: Foyer 
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Figure 8.4 Created Room Schedule 

13. Go back to the Level 1 view 
14. Click the Architecture tab 

15. Click the Room icon 
16. On the Option Bar select the 102 Office from the drop-down menu 
17. Place it in the office to the right of 101 Office by clicking on the canvas 
18. Repeat steps 16 and 17 from left to right until all 8 office rooms are placed as 

shown in Figure 8.5 (Make sure the Tag on Placement is enabled) 
19. Place the remaining rooms as shown in Figure 8.5 
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Figure 8.5 Placed rooms 

Add and modify a color scheme 

1. Click the Annotate tab 

2. Click the Color Fill Legend 
3. Click on the white space of the canvas to place the Room Legend 
4. In the Space Type and Color Scheme Change the Space type to Rooms and the 

Color Scheme to Name the click OK 
5. Select the Room Legend on the canvas 

6. Click the Edit Scheme icon 
7. Change the Room colors to the following RGB values 

1. Conference: 185 205 182 
2. Cubicle: 199 233 228 
3. Foyer: 191 199 175 
4. Hall: 170 189 198 
5. Office: 233 226 148 
6. Open Workspace: 157 206 230 

8. Click Apply and OK 
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Figure 8.6 Room Legend with modified lighter colors 

Add tags and color fill in section 

1. In the Level 1 view, click the View tab 

2. Click the Section tag icon 
3. Draw a section line across the Level 1 view from left to right as shown in Figure 8.7 

Figure 8.7 Section Line placed on the Level 1 floorplan 
4. In the Project Browser, double-click on Section 1 to open the view 
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5. In the Properties Palette, click the box next to Color Scheme 
6. In the window, change the Category to Rooms 
7. Select the Name 
8. Click Apply and OK 
9. Click on the Annotation tab 

10. Click Tag All icon 
11. In the Tag All Not Tagged window, click the box next to Room Tags 
12. Click Apply and OK 

Figure 8.8 Color Scheme and Room tags applied in the Section 1 view. 

Schematic Design, Room tag and Color fill Video Tutorial 
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Chapter 9: Materials, 
Visualization and Rendering 

9.1 MATERIALS 

Create a Material 

Until this chapter materials were created while an element was modified. A material 
can be created without having the make or attach it to an element. When a material 
is created through this process it is available in all material windows for quick access. 

1. Click on the Manage tab 

2. Click the Material icon 
3. In the Search bar type Oak 
4. Select the Oak Flooring 

5. At the bottom of the window click the Creates Material icon  and select the 
Duplicate option 

6. Select the duplicated material and rename the material New Oak Flooring and 
click the Graphics tab on the right 

Graphics tab 

1. The Surface Pattern is shown in plan and 3D views to depict how the floor planks 
are laid, click the box next to pattern and change it to the Wood Board Wide 

2. The Cut Pattern is shown in section, click the box next to Foreground Pattern and 
change it to Diagonal Up 

3. Click the Appearance tab 
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Figure 9.1 Graphics tab options 

Appearance tab 

1. Select the box next to Image. This window is used to change the Image, 
Brightness, Position, Rotation, Scale and how the image repeats once applied to 
an element 

2. Change the image to Wild_Cherry_natural1 and the Scale to 10’ x 10’ 
3. Click Done 

TIP 

Other images can be added to the library by following this address path 
C:/Program Files (x86)/Common Files/Autodesk Shared/Materials/Textures/
1/Mats 
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4. The Relief Pattern is used to show if a pattern is rough or smooth. Toggle the 
amount or use the text bar to adjust the relief pattern to 1.25 

5. Once done click Apply then OK. This material will be available throughout the 
project 

Figure 9.2 Appearance tab options 

Asset Library 

1. Click on the Manage tab 

2. Click the Material icon  

3. At the bottom click the Creates Material icon  and select the Create New 
Material option 

4. Name it Metal Panel 

5. Click the Asset Library icon 
6. In the Search bar type Metal Panels – Blue and press the Enter key 

7. Select the Replace Asset  on the right side of the options bar 
8. Click the X to close the Asset Library 
9. Under Appearance click the Relief Pattern Image Box 

10. Click the source and change it to TileRectBump and click OK 
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11. Click Apply and OK 

Figure 9.3 Asset Library window 

Assign a Material by Element 

1. Open the 3D view, select the wall on the first floor that separates the foyer from 
the offices as shown in Figure 9.4 

2. In the Properties Palette, click the Edit Type button 
3. Click the Duplicate button and name the wall Metal Panel 
4. Next to Structure click the Edit button 
5. Change both Finish 2 [5] to the Metal Panel material by clicking the 3 dots button 

6. Click OK to close the windows 
7. To view the result, make sure the Visual Style is set to Realistic 
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Figure 9.4 Metal Panel material applied to an existing wall 

Assign a material using the Paint tool 

1. In the 3D view, adjust the view to see the mezzanines as shown in Figure 9.5 
2. Click the Modify tab 

3. Click the Paint tool 
4. Select the New Oak Flooring 
5. Hover over the Level 2 and when the top face is highlighted, click to place the 

material 
6. Do the same for Level 3 and 4 as shown in Figure 9.5 
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Figure 9.5 Applied New Oak Floor material 

9.2 VISUALIZATION 

Create a presentation elevation view 

1. In the Project Browser, locate the Elevations 
2. Right-click the South elevation and click Duplicate View then Duplicate 
3. Rename the copy South Presentation 
4. On the View Control Bar, change the Visual Style to Shaded  and Detail Level to 

Fine 
5. Hide the reference levels and any other visible markers 
6. In the Properties Palette, click the Edit button next to Graphic Display Options 
7. Change the following properties 

◦ Model Display: check the Smooth Lines with Anti-Aliasing 
◦ Shadows: check both Cast Shadows and Show Ambient Shadows 
◦ Depth Cueing: Check Show Depth, Fade start to 25, Fade Limit to 25 
◦ Lighting: Sun to 80, Ambient Light to 10, Shadows to 60 

8. Click OK to accept these changes 
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Figure 9.6 South Presentation view 

Create a presentation 3D view 

1. In the project browser, create a duplicate 3D view and name it 3D Presentation 
2. Change the Visual Style to Shaded  and the Detail Level to Fine 
3. On the View Control Bar, click the Visual Style icon and click Graphic Display 

Option 
4. Change the following parameters 

◦ Model Display: check the Smooth Lines with Anti-Aliasing 
◦ Shadows: check both Cast Shadows and Show Ambient Shadows 
◦ Lighting: Sun to 30, Ambient Light to 20, Shadows to 30 
◦ Background: Gradient 

5. Click OK to accept these changes 
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Figure 9.7 3D Presentation 

Exploded 3D Model 

1. Duplicate the 3D view again and name it 3D Exploded Axon 

2. Click the Modify icon 
3. Select the roof 

4. Click the Displace Element icon 
5. Use the blue toggle arrow and pull the roof up 
6. Do the same for the Ceiling and the three roof extrusions as shown in Figure 9.8 

7. Select the roof and click the Path icon  on the ribbon 
8. Hover the cursor over the corners of the roof and click to place a dashed line at 

each corner. These should automatically snap to the corners of the selected 
element 
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Figure 9.8 Exploded roof with path lines 

 

1. Zoom into the punched opening windows along the first floor 

2. Select the first window, Click the Displace Element icon  and drag it from the 
wall using the green toggle arrow 

3. Select one of the southern walls and click the Displace Element icon 

4. Select the wall again and click the Edit icon 
5. With the Add option enabled, select the other two walls 

6. Click the green  checkmark to finish editing 
7. Use the green toggle arrow to pull the elements away from the building 
8. Add path lines as shown in Figure 9.9 
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9. Pull the windows out from the wall and add path lines 

TIP 

Work from the largest items to explode first then before smaller items. 
The path lines will extend to the place they were first displaced from 

 

Figure 9.9 Exploded Isometric 
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9.3 RENDERING 

Render a view 

1. Open the Level 4 floor plan 

2. Go to the View tab and click the 3D view  icon drop-down menu 

3. Click the Camera icon 
4. Click and hold the cursor down in the up-right corner of the 4th floor 
5. Drag the cursor down and slightly to the left to view the curtain wall, parametric 

bench and 3D wall. 
6. When the view opens, use the crop region lines to adjust the view 

TIP 

-To view the camera extents go to the Project Browser and right-click the 
3D View 1 then click Show Camera. This will enable you to see the camera 
placement in Level 4 
-Use the Full Navigation Wheel to adjust the view 

7. Click the Render icon 
8. In the Render window change the following settings 

◦ Setting to Medium 
◦ The Lighting scheme to Exterior: Sun and Artificial 
◦ Style: Sky Cloudy 

9. Click Render 
10. Once the process is complete, use the Adjust Exposure levels until the desired 

effect is reached. 
11. Export as a jpeg (or another file type that is most appropriate) 

Chapter 9: Materials, Visualization and Rendering  |  151

www.dbooks.org

https://www.dbooks.org/


Figure 9.10 Render of Parametric bench and 3D wall 

Interactive (Ray Trace) rendering 

Ray Trace allows the user to view, set, adjust, and save render views before the final 
rendering takes place. 

1. Open the Level 4 floor plan 

2. Go to the View tab and click the 3D view  icon drop-down menu 

3. Click the Camera icon 
4. Click and hold the cursor down in the up-right corner of the 4th floor 
5. Drag the cursor down and slightly to the left to view the curtain wall, parametric 

bench, and 3D wall. 
6. When the view opens, use the crop region lines to adjust the view 

7. Go to the View Control Bar and change the Visual Style to Ray Trace . Be patient 
because the image will take a moment to become clear. 

8. Click on the Visual Style icon again 
9. Click the Graphic Display Option 

10. Adjust the settings until the desired render is reached 

11. On the ribbon in the top right corner, click the Save icon 
12. Name the view 

13. Click the Close button 
14. Render the image 
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Figure 9.11 Saved render settings before final render takes place 

Cloud rendering 

Cloud render allows a user to send renderings through the cloud using their AutoDesk 
account where the final images are processed and received through email. This allows 
the user to continue working while the image is rendering. 

1. Click on the View tab 

2. Click the Render in Cloud icon 
3. An instruction window will open describing what the process is, click OK to 

progress forward 
4. Select the 3D View, Still Image, and Standard quality. Note that some options 

require credits to be used to purchase higher-quality renders through this option. 
5. In the Next window, click Render in Background 
6. After a short period, open your email and retrieve the image 
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Figure 9.12 Render in Cloud windows 

 
 

Material and Visualization Video Tutorial 
Rendering Video Tutorial 
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Chapter 10: Details and 
Annotations 

10.1 DETAILS 

Detail Lines (Linework) 

Linework is added using the same tools that are available to build elements. Line styles 
offer different weights and patterns such as dashed, dash-dot, etc. 

Field Region 

Field regions add patterns or hatches to help describe a material. 

Masking Region 

Masking regions either hide linework or fade linework using transparency. 

Detail Component 

A detail component is a profile family that is saved individually and uploaded into the 
project such as top and bottom plates, blocking, soldier bricks, etc. 

Repeating Elements 

A repeating element is a time-efficient tool used to draw a repeating detail in a linear 
fashion such as a regular brick, soldier bricks, grout spacing, etc. 
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Detail Groups 

A detail group is used to draw multiple details under a single name. 

10.2 ADDING 2D DETAILS 

Create a Masking Region 

1. In the Level 1 view, click the View tab 

2. Click the Section icon 
3. Place a section cut across Office 104 and 108 as shown in Figure 10.1 (left) 
4. In the Project Browser, open Section 2 

5. Under the View tab, click the Callout icon 
6. Click and drag to place 4 callout bubbles as shown in Figure 10.1 (right). If the 

callout tag is placed over the building section, click the blue dot closest to the 
bubble and drag it off the building. 

Figure 10.1 Section cut placed in Level 1 view (left) and Callouts placed in Section 
view (right) 

7. In the Project Browser open Section 2 – Callout 1 
8. Adjust the crop box if needed by clicking and dragging the blue dots 
9. On the Option View Bar change the Detail Level to Fine  and make sure the 
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Visual style is on Hidden Line 
10. In the Annotate tab, click the Region drop-down arrow and click the Masking 

Region icon 
11. In the Lines Style panel, change the line to <invisible lines> 
12. Use the rectangle tool  to cover the floor where it intersects the wall 

13. Click the green  checkmark to finish the mask 
14. Select the mask and adjust the extents using the blue dots to match Figure 10.2 

Figure 10.2 Masking region before (left) and after placement (right) 

Create a Field Region 

1. In the Section 2 – Callout 1 view, go to the Annotation tab 

2. Click the Region drop-down arrow and click the Filled Region icon 
3. Change the Line Style to Thin Lines 
4. Use the Type Selector to choose the Diagonal Up pattern 
5. Place the same filled region for the flooring substrate under the finished floor as 

shown in Figure 10.3 
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Figure 10.3 Filled regions (highlighted in yellow) 

Add Detail Lines (linework) and Component Detail 

1. In the Section 2 – Callout 1 view, click the Detail Line icon 
2. Change the Line Style to Thin Lines and draw the lines as shown in Figure 10.4 
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Figure 10.4 Thin lines drawn are highlighted in yellow 
3. Continue using the Thin Line style and draw the blocking, top plates, and bottom 

plates. Use Figure 10.5 for reference. The actual dimensions of wood members are 
1.5” thick. 
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Figure 10.5 Blocking, top plates and bottom plates drawn using Detail Lines 

Create a Repeating element 

1. In the Section 2 – Callout 1 view, draw a <invisible lined> masked region over the 
brick layer 

2. Use the Bring to Front icon  if the region is not showing 

3. Click the Component  drop-down arrow and click the Repeating Detail 

Component 
4. Use the Type Selector to choose the Repeating Detail Brick 
5. Click the bottom left corner of the brick layer and drag the cursor up to place the 

repeating pattern as shown in Figure 10.6 

6. Click the Detail Lines icon 

7. Use the Start-End-Radius tool  to create a grout line 
8. Use the Copy tool to make multiple grout lines as shown in Figure 10.6 

160  |  Chapter 10: Details and Annotations



Figure 10.6 Repeat brick component over 

10.3 ANNOTATIONS 

Tag by material 

1. In the Annotate tab click the Material Tag icon 
2. Hover the cursor over the brick, click on the brick to place the first part of the tag, 

drag the cursor further to the left, and click the screen. Now the first half of the 
leader line is placed. 

3. Drag the cursor to the left one last time and place the last of the leader line 
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Figure 10.7 Leader line 

Tag by Text 

1. In the Annotate tab click the Text icon 

2. Click the Two Segments  icon on the Leader Panel 
3. Click on the stud to place the end of the leader liner. Drag the cursor to the left 

and click again, drag to the left and finish placing 
4. A text box will appear, type 2X6 Wood Stud 

TIP 

If the tag is not showing, click on the crop box. Adjust the extents to the 
dashed box around it and pull the left side far out. 

 
5. Select the Text 
6. In the Properties Palette use the Type Selector to choose the Text 3/32” Arial 
7. Click the Edit Type 
8. Click duplicate and accept the default name 
9. Next to Leader Arrowhead use the drop-down to select the Arrow Filled 15 Degree 
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Figure 10.8 Text with leader lines pointing at their respective material level 

TIP 

Steps 6 through 9 are the same to change the text style, size, color, leader line 
weight, and line color. 

Tag by Category 

1. Open the Level 1 Floorplan view 

2. In the Annotate tab click the Tag by Category icon 
3. Click on each door and window as shown in Figure 10.9 
4. Adjust the placements so each symbol is not on top on the plan 
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Figure 10.9 Doors and Windows Tags placed In Level 1 view 
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Legends and Keynote Legends 

Legends 

Legends are used to identify the symbols and add notes that can be added to multiple 
sheets during the Construction Document phase. 

Keynote Legends 

Keynotes are a combination of text references in a legend that provide written 
information about elements, materials, or codes in the Construction Document. 

1. In the Level 1 view click to open the View tab 

2. Click the Legend icon 
3. Name the new legend Symbols 
4. Choose the ¼” = 1’ 
5. In the Project Browser, expand the Families section then expand the Annotation 

Symbols section 
6. Expand Door Tag then click and drag the Door Tag onto the canvas 
7. Do the same for Spot Elevation – Target Filled, Section Head – Filled, Window Tag 

and Wall Tag ½” 

8. Click on the Annotate tab then click on the Text icon 
9. Add a text box to the left of the symbols as shown in Figure 10.10 

10. Use the Type Selector to change the text to 3/32” Arial 
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Figure 10.10 Symbol Legend 

Dimensions 

1. Open the Level 1 view 
2. Click the Annotate tab 

3. Click the Aligned Dimension 
4. Hover over the west wall on of the Open Workspace 
5. Use the Tab key to cycle through the options and choose the exterior face, click to 

place the first edge 
6. Measure from this wall to the exterior face of glass curtain wall 
7. Practice placing more dimensions including the Angular, Radial and Arc Length 

dimensions as shown in Figure 10.11 
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Figure 10.11 Dimension strings added to the Level 1 View 

Modifying Dimensions 

1. Select the smaller radius dimension on conference room 119 
2. Click Edit Type 
3. Duplicate and accept the default name 
4. Change the following properties 

◦ Text Size: 1/32” 
◦ Units Format: Click the gray button 

▪ Uncheck the Use project settings 
▪ Change Rounding to nearest 1/8” 

5. Click Apply and OK 
6. Hover the cursor over the blue dot underneath the dimension text 
7. When the words Drag Text appear, click and hold the blue dot and drag it away 

from the leader line 
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Figure 10.10 Modified radial dimension 

 
Details and Annotations Video Tutorial 
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Chapter 11: Workflow | 
Worksharing 

11.1 WORKFLOW 

CAD and BIM users within a firm follow the same design and construction phases that 
answer the what, where, and how, but the time and payroll spent in each phase varies 
between the programs. 

CAD versus BIM workflow 

CAD 

In the CAD program, there is one 2D drawing per file that is then linked into another file 
for reference, so important elements align such as exterior walls or structure. Elevations 
and interior wall designs are orthographically projected from linked floorplans to create 
vertical information. When changes are made to a project a team member is required 
to edit each file individually. 

Firms created a guide from experience on how many hours it generally takes to 
complete tasks at each of the 4 design phases. When using CAD more hours are used 
from the design development through the construction documentation phase. 

BIM 

In the BIM program, all 2D and 3D drawings are in one file where the 3D model 
automatically produces all necessary plans, sections, elevation, and rendered views. 
BIM uses GIS data (Geographical Information Systems) to position a project where 
the environment’s sun angle or average temperature can accurately predict daylight 
studies, energy analysis, and material performance. For example, a wall envelope can 
include the R and U values of insulation or windows to test the energy efficiency. 

Structural, MEP, and HVAC designs are typically created by an engineering firm 
then linked into the architecture file. Engineering design requirements can alter the 
architectural design such as codes that determine airflow or CFD (Computational fluid 
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dynamics). A project may require the ceiling cavity to be increased to house the 
appropriate HVAC system that controls the airflow. 

BIM generally uses the same number of hours from the Conceptual and Schematic 
phase through the Design Development, but it offers a significant decrease in hours to 
complete the Construction Document phase. When a change is made in any view of 
the model whether it be 2D or 3D, all other views are adjusted simultaneously. 

BIM Roles 

Typically there are 3 types of employees needed to complete the construction 
documentation and they are the Architect, the Model Maker, and the Draft Organizer. 

The Architect 

The Architect is typically the real architect in control of the project. This person oversees 
the design decisions, construction feasibility, material choices, code requirements and 
makes sure the project is consistent from beginning to end. 

The Model Maker 

The Model Maker is responsible for building the 3D model and 2D views which include 
families of windows, doors, casework, structure components (in walls, floors, roofs, etc.) 
and any other items accounted for in a CD set. 

The Draft Organizer 

The Draft Organizer takes all views from the Model Maker and the codes and 
requirements from the Architect and sets up all sheets, schedules, and views then 
apply detailed information such as dimensions, keynotes, and annotations. 

11.2 WORKSHARING 

Worksharing allows more than one user to access the same model and work 
simultaneously. Users work from individual local Revit files.  Each local file 
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communicates to the central model that is located to a Cloud-based system under the 
C:/ of each user’s computer. 

Install Google Drive/DropBox 

Each user needs to follow these steps to locate the Google Drive in the appropriate 
folder. 

The following steps are for users who have not downloaded Google Drive or DropBox 
to their personal devices before. If Google Drive is already on the computer, please skip 
to the next section. 

TIP 

This process works best if a new google account is created. Revit files are 
heavy and will use a lot of storage limiting a user’s personal account 

1. To use Google Drive, go to https://www.google.com/drive/download/ and click the 
personal download button. 

2. Follow the installation instructions 
3. When the download is complete, log in to the google account 
4. Under the My Laptop tab, uncheck the Desktop, Documents, and Pictures options. 
5. On the left panel, click to open Google Drive 
6. A user can sync every folder in Google Drive or just specific folders. Select the 

folders that are needed for quick access when working on a project. 

TIP 

1. Folders that sync to the hard drive do take up space on the 
computer, only sync what is necessary to link to the project. This can 
help reduce lagging 

2. If a new account is created, try following a folder nomenclature 

▪ 00_Central File (save the central here) 
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▪ 01_Project Families (save all family files here) 
▪ 02_Project Masses (save all massing files here) 
▪ 03_Project Materials (save all material, images, etc here) 

7. Change the folder location to the computers C:/ drive. This is the most important 
part because each user’s folder address has to be exactly the same to access the 
project. For example C:/Google Drive/00_Central File 

8. Click OK to allow the files to sync 

Relocate an existing Google Drive to the C:/ 

The following steps are for users who have downloaded Google Drive or DropBox 
to their personal devices before. Google Drive does not allow you to change the file 
location after an account has already been synced therefore you need to “Quit Back 
Up and Sync”. 

There are two methods to changing the file location to a Google account that is 
already active on your desktop. 

Option 1: 

1. Access the Google Back up and Sync  that is located on the computer tool bar 
2. Select the Settings icon (3 dots) 
3. Select Quit Backup and Sync 
4. Open the File Explorer and locate the Google drive folder 
5. Copy and Paste the folder into the C:/ drive 
6. Delete the original Google Drive folder 
7. Re-open the Backup and Sync 
8. The program will prompt you to locate the missing file, select the Locate button 
9. Use the Browse for folder window to access the C:/ drive and select the new 

Google Folder 
10. Another window will appear asking you to confirm this choice, select Confirm 

Option 2: 

1. Access the Google Back up and Sync  that is located on the Windows tool bar 
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2. Select the Settings icon (3 dots) 
3. Select Preferences 
4. Go to the Settings tab on the left of the window 
5. Click the disconnect account icon 
6. This will sign out of the account 
7. Move the Google Folder to the C:/ 
8. Access the Google Back up and Sync that is located on the Windows tool bar 
9. Select the Settings icon (3 dots) 

10. Select Backup and Sync 
11. Sign into the account 
12. Go to the Google Drive tab on the left 
13. A blue underlined “Change..” will be available to choose a new location 
14. Select Start to begin syncing 

TIP 

• If this does not work follow these steps 

◦ Access the Google Back up and Sync 
◦ Uninstall from the Add/Remove Programs 
◦ Download using the previous instructions 

 

Set up a Central File 

Only one person from the group needs to complete these instructions 

1. Open the Revit application 
2. Click New on the left side of the home page 
3. Choose the Architectural model from the drop-down menu 
4. Click OK 
5. Click the Collaborate tab 

6. Click the Workset icon 
7. A window will open “You are about to enable Worksharing.” Click OK 
8. In the Workset window, worksets can be separated by group members name or by 

construction sections such as Exterior Shell, Interior Partitions, Egress Core, etc. 

◦ Select New 
◦ Enter their name 
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◦ Click okay to accept their name 
◦ Click OK once all names have been added to exit the Worksets window 

9. Click OK 

Figure 11.1 Workset window with created user worksets 
10. Click File, Save As 
11. Select the Project Option 
12. Choose the Central File folder created in the Google drive account in the C:/ 
13. Title the file “Project Title_Central Model” 
14. Click Options on the bottom right corner 
15. Check the box next to Create Central Model 
16. Click OK to close the Options window 
17. Click OK to save the project 
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Figure 11.2 Save as window to create a Central Model 

Set up Local Files 

All users from the group need to complete these instructions 

1. Open Revit 
2. On the Home Page click Open 
3. Locate the Central File 
4. At the bottom of the Open window make sure the Create New Local is checked 
5. Click Open 
6. Revit will automatically choose the Document folder to save the local file. Do not 

change this. 

Access the local Revit model 

There are two methods to access a Revit project. 

Option 1: 

1. Open Revit then locate the local file from the Document folder 
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Option 2: 

1. Click on the Central Model that appears in the main space of the Revit Home Page 

◦ A window will open asking “By opening this central model, you will create a 
local copy of it” 

◦ Choose to “Append timestamp, to existing copy” or “Overwrite existing copy” 

▪ Timestamp creates a new timestamped file 
▪ Overwrite saves a new local file over the existing local file 

◦ Once the Local file is open, go to the Collaborate tab 

◦ Click the Workset Icon 
◦ Use the Drop-down menu under editable and choose Yes 
◦ Click OK 

WorkSharing important icons 

▪ Synchronize model  : Uploads all the work a user has done and saves it 
to the central model for the other users to see 

▪ Reload Latest  : Loads what other users synchronize after the opening 
of a project 

▪ Relinquish Mine  : Releases all work done that allow other users to 
make edits or updates 

Important notes when working from a cloud shared model 

1. Always Synchronize and Relinquish Mine before closing the project 
2. Assign group members model/building elements by topics such as Floors, Walls, 

Windows, Doors, Legends, Sheets, etc. 
3. Save the file often without syncing to the central 
4. Communicate with the other users before clicking the Synchronizing(updating) 

◦ Only synchronize the model with the Google drive  icon shows the arrow 
point upward 

◦ Never synchronize when the arrows form a circle  – this means the central 
model is updating. If members synchronize at the same time the Central file 
will corrupt and progress will be lost 

5. If the Central File is corrupt 
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◦ A user who can access the file should go to the Collaborate tab 
◦ Click the Manage Model drop-down menu 

◦ Click Repair Central Model 

6. Sometimes another error may occur where all the work is lost. 

◦ Save-As the corrupt local file by another name and close 
◦ Open the local file again 
◦ Try to copy, paste the elements over 

7. If the internet connection is lost 

◦ Wait until it is back up to sync before closing the file 
◦ Save-As under a new name 
◦ If the computer needs to be shut down then try to copy/paste it over later 

8. Randomly one user may end up with control rights to another user’s work. 

◦ Open the file 
◦ Go to the Collaborate tab 

◦ Click Relinquish Mine 

◦ Click Sync separately 

 

Workflow and Workshare Video Tutorial 
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Chapter 12: Schedules and 
Project Phasing 

12.1 CREATE A SCHEDULE 

1. Click the View tab above the Ribbon 

2. Click the Schedule icon  drop-down arrow 

3. Click the Schedule/Quantities icon 
4. In the New Schedule window change the following parameters, see Figure 12.1 

◦ In the Filter drop-down list, only check the Architecture option 
◦ Under Category select Doors 
◦ Name it “Door Schedule” 
◦ Click OK 

Figure 12.1 New Schedule window with Door category chosen 
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5. In the Schedule Properties window click the Fields tab 
6. Select the following available fields and add them to the schedule fields in the 

following order using the Add Parameters icon  , see Figure 12.2. 

◦ Type, Type Mark, Width, Height 

Figure 12.2 Schedule Properties window with fields selected 

7. In the Sorting/Group tab, sort by Type and uncheck the option “Itemize every 
instance”, see Figure 12.3 
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Figure 12.3 Sorting/Grouping tab in the Schedule Properties window 

1. In the Formatting tab, change the Type Mark alignment to Center, see Figure 
12.4 
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8. 
Figure 12.4 Formatting tab in the Schedule Properties window 

1. In the Appearance tab check the Outline box and use the drop-down menu to 
choose Medium Lines, see Figure 12.5 
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9. 
Figure 12.5 Appearance tab in the Schedule Properties window 

10.  Click OK 

Figure 12.6 Completed Door Schedule 
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12.2 PROJECT PHASING 

For this section consider that an elementary school will design an addition to 
accommodate an increased number of student enrollment. Revit can classify parts of 
the elementary school renovation project in phases such as New, Existing, Demolished, 
or Temporary. 

New Construction consists of all elements that are added to the school such as a new 
foundation, walls, floors, windows, and more. 

Existing Construction consists of all elements from the original building footprint. 
Demolishing Construction classifies anything that will be taken away from the 

project, such as the exterior wall torn down for the new construction to attach to. 
Temporary Construction consists of all elements used during the construction such 

as fences, scaffolding or braces. 

Create a Phase 

1. Click the Manage tab 

2. Under the Phasing Panel, click the Phases icon 
3. In the Phasing window select, the number to the left of the option Existing 
4. Then select the After button on the right 

TIP 

Phases cannot be reorganized once added, so aware of if the Before or 
After option should be chosen 

5. Click the Name Phase 1 and rename it Demolish, see Figure 12.7 
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Figure 12.7 Project Phasing options in the Phasing window 
6. Click on the Phase Filters tab at the top of the Phasing window 
7. Click the New button along the bottom 
8. Rename the new filter Demo Only 
9. Change the following parameters, see Figure 12.8 

◦ New to Overridden 
◦ Existing to Not Displayed 
◦ Demolished to Overridden 
◦ Temporary to Not Displayed 
◦ Click Apply and OK 
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Figure 12.8 Phase filters in the Phasing window 

10. In any view, select the element 
11. In the Properties Palette scroll to the bottom and use the drop-down menu to 

change the Phase to Demolish 
12. Select Apply 

Figure 12.9 Phasing change applied to an element in the project 

 

Schedules and Phases Video Tutorial 

Chapter 12: Schedules and Project Phasing  |  185

www.dbooks.org

https://youtu.be/Tm4CvwQGoFY
https://www.dbooks.org/


Chapter 13: Drawing Sets and 
Construction Documents 

13.1 CREATE SHEETS AND LISTS 

Create a sheet 

1. In the View tab, click the Sheet icon 
2. Click the Load button 
3. Navigate to the Title block folder and open it 
4. Select the 11X17 Horizontal option 
5. Click Open 
6. In the New Sheet window, click OK 
7. To modify the text simply hover over the text until the text box appears and 

double-click to access it 

Figure 13.1 Created sheet with default horizontal Autodesk title block template 
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TIP 

Edit a title block by selecting the edge of the paper and then click the 

Edit Family icon  then Save As a new file. Or create a new title block 
through a Family template 

Create a sheet list 

1. In the View tab, click the Schedules  drop-down arrow 

2. Click the Sheet List icon 
3. In the available fields select the following options (in order) and add them to the 

Scheduled Fields 

◦ Sheet Number, Sheet Name, Sheet Issue Date, Designed By 

4. Under the Sorting/Grouping tab choose to Sort by Sheet Number 
5. Under the Appearance tab, enable the Outline by checking the box and choose 

Medium Lines 
6. Click OK 

Figure 13.2 Sheet List 

TIP 
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The Sheet List will update as more sheets are created 

 

13.2 SETTING UP SHEETS 

1. Open the A101 – Unnamed sheet 
2. On the Canvas, double-click the Unnamed text box and change it to First Floor 

Plan 
3. Click on the View tab 

4. On the Sheet Composition panel, click the View icon 
5. In the Views window, click the Floor Plan: Level 1 option 
6. Click the Add View to Sheet 
7. Click on the Canvas to place the view 
8. Double-click on the placed view (or viewport) to access the floor plan 
9. On the Option View Bar change the scale to 1/16” = 1’ 

10. In the Properties Palette under the Extents section, Check the box next to Crop 
View and Crop Region Visible 

11. Adjust the extents as shown in Figure 13.3 then click the green  checkmark. 

TIP 

What area is chosen by the crop view extents is what will be shown 
when the view is added to a sheet. The view title will be justified to the left 
extent, therefore, to work efficiently, pull the extents in as close to the 
drawing as possible to avoid editing in the sheets. 
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Figure 13.3 Adjusting the Crop view in plan view 
12. Move the views title bar by highlighting its elements the use the Move tool to 

place it under the floor plan 
13. To modify individual elements of the title bar click them to access their extents 

13.3 ADD SCHEDULES TO A SHEET 

1. On the A101 – First Floor Plan view, go to the Project Browser 
2. Expand the Schedules/Quantities 
3. Click and drag the Room Schedule to the canvas 
4. Click to place it in the top right corner of the sheet as shown in Figure 13.4 
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Figure 13.4 Schedule added to sheet A101 
 

Drawing Sets and Construction Documents 
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Chapter 14: Site Modeling 

3D site modeling covers all elements added around the building structure including 
vegetation, infrastructure, vehicles, and contouring land or topography. 2D site design 
consists of property lines, topography lines, and the building pad. A building pad is 
required when topography is added to a 3D model because it can cut through the 
topography where a floor is not able to. 

There are 3 methods for creating topography in Revit. 

• Placing points at a specific location and assigns each point an elevation height 
• Import a CAD filed that has lines or points with assigned elevations, usually 

acquired from a GIS shapefile. 
• Import a CAD file that has been generated by a civil engineering program. 

14.1 Create topography with CAD import 

1. In the Project Browser, double click Site under the Floor Plans section 

2. In the View tab, click the Import CAD icon 
3. Select the Topography file that was downloaded from Canvas 
4. Click Open 

TIP 

If the topography does not appear at the top of Level 1 change the Top 
Offset to a negative number until it is just above the floor. This example was 
adjusted to -48’ 6” 

5. Open the 3D view from the Project Browser 
6. Click the Massing & Site tab 

7. Click the Toposurface icon 
8. Under the Tools panel, click the Create from import drop-down menu 

9. Click the Select Import Instance 
10. Select the linked CAD file 
11. In the Add Points from Select Layers window, uncheck the 0 layer 
12. Click OK 
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13. Click the green  checkmark to finish 

TIP 

These CAD files may have too many points and can be simplified by 

clicking the Simply surface icon 

Figure 14.1 Toposurface created using a linked CAD file. 

Add a Building Pad to the Imported CAD file Toposurface 

1. In the Site view go to the Massing & Site tab 

2. Click the Building Pad icon 

3. Use the Pick Lines tool  to select the edges of the roof and floors that are visible 

then clean up the lines using the Trim tool 

4. Click the green  checkmark to finish drawing the building pad 
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Figure 14.2 Building Pad cutting through the CAD imported topography 

14.2 CREATE TOPOGRAPHY BY PLACING POINTS 

1. Open the Site view 
2. Click the Massing & Site tab 

3. Click the Toposurface icon 

4. Click the Place Point icon 
5. On the Options Bar change the elevation to 0’ 0” 
6. To the right of the existing model click to place a nonlinear line similar to Figure 

14.3 
7. Change the Elevation to 10’ 0” and create another nonlinear line 
8. Continue to complete lines with 20’, 30’, 30’, and 0’ elevations 

9. Click the green  checkmark to finish the toposuface 

Figure 14.3 Toposurface created by placed points 
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TIP 

To see the thickness of earth, enable the section box from the Properties 
Palette and cut through the toposurface 

14.3 ADD A BUILDING PAD 

1. In the Site view go to the Massing & Site tab 

2. Click the Building Pad icon 

3. Use the Rectangle tool  to draw a shape between the 20 and 30-foot levels as 
shown in Figure 14.4 

Figure 14.4 Building Pad drawn in the Site view 

4. Click the green  checkmark to finish drawing the building pad 
5. Select the building pad and change the Level to see how the toposurface 
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responds to the building pad. 
6. Use the Section box to cut through the Building pad 

Figure 14.5 Building Pad at Level 2 with a section box cutting the toposurface 

Topo Surface and Building Pad Video Tutorial 
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Chapter 15: MEP - Fire 
Protection and Fabrication Parts 

 

15.1 SET UP A MECHANICAL PROJECT AND LINK AN 
ARCHITECTURAL FILE 

1. Open the Revit application 
2. In the Revit Home Page click New 
3. In the New Project window use the drop-down menu to choose the Systems 

Template 
4. Choose to create a new Project 
5. Click OK 
6. Go to File then Save As 
7. Save the project in a known location under the name Class Project 1 MEP_Last 

First 

8. Go to the Insert tab and click the Link Revit icon 
9. Link the Class Project 1_Last First.rvt file then click Open 

10. Select the linked file and Pin  the file to the canvas 
11. Go to the Project Browser and expand Mechanical 
12. Expand the Mechanical Elevations 
13. Double click to open any elevation view 
14. The linked Revit file levels show but are not accessible. The mechanical template 

default levels are hidden behind the linked file. Click the Level 2 at the 10’0” height 
then click and drag the hollow circle out to the right as shown in Figure 15.1. 

15. Adjust the Level 2 height to 11’0” to match the linked file 
16. In the Architecture tab use the Level icon to add Level 3 and Level 4. Rename 

them Level 3 and 4 respectively but do not change the names of corresponding 
views. 
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Figure 15.1 Levels added to the Mechanical file 
17. In the Project Browser under the “???” category, expand the Ceiling Plans. 
18. Select one of the Ceiling Plans 
19. In the Properties Palette next to Sub-Discipline, type Fire Protection. For the 

remaining ceiling plan, use the drop-down arrow and select Fire Protection. When 
a sub-discipline is changed, its’ location in the project browser also changes. 
Notice how these views are now under the new Fire Protection category. 

20. Rename the views by their level #, plan type, and Mechanical type. A window will 
appear asking to change the corresponding views, select No. 

◦ 3 – Ceiling FP 
◦ 4 – Ceiling FP 

21. In the Project Bowser under Mechanical/HVAC/Ceiling Plans, select 1 – Ceiling 
Mech and change the Sub-Discipline to Fire Protection. 

22. Rename the view to replace the Mech with FP as shown in Figure 15.2 

TIP 

If one or more plans do not allow the sub-discipline to be changed follow 
these steps. Select the plan, click the Edit type button from the project 
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browser, select the Mechanical Plan button, under the View properties 
section, scroll down then modify the Sub-Discipline located here. Click 
Apply then OK to close all windows. Lastly, rename the views. 

 
23. Repeat these steps for all the Floor Plans located under the HVAC category. 
24. Rename the plan views by their level #, plan type, mechanical type as shown in 

Figure 15.2, but do not change the corresponding views 
25. Change the {3D} view Sub-Discipline to Fire Protection 

Figure 15.2 Created floor and ceiling plans are shown in the Project Browser 
26. Open the first floor Fire Protection plan from the project browser 
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27. In the Properties Palette click the Edit button next to View Range and change the 
Bottom and View Depth to Unlimited 

28. Click OK to close the window 
29. In the Properties Palette click the Visibility/Graphics Override button 
30. Use the Filter List drop-down menu to check the boxes next to Mechanical and 

uncheck the other options 
31. Scroll down to the bottom of the Visibility list and make sure Parts are checked 
32. Click OK to close the window 

15.2 SET UP FIRE PROTECTION TYPES 

1. In the Systems tab, click the Pipe icon 
2. In the Properties Palette click the Edit Type button 
3. Click Duplicate 
4. Name it “Sprinkler System” 
5. Click the Edit button next to Routing Preferences 
6. Click the Load Family button 
7. Navigate the following folder path: Pipe/Fittings/Malleable Iron/Class 300/

Threaded 
8. Select all of the files using the SHIFT key 
9. Once all are highlighted, click Open 

10. Under Pipe Segment select the Copper K option 

11. Use the green  sign on the left to add a row under Pipe Segment 
12. In the Routing Preferences window change each Content and sizes as shown in 

Figure 15.5, then click OK to close all windows
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Figure 15.3 Routing Preferences selected content and sizes 

15.3 ADD SPRINKLER HEADS 

1. In the Project Browser under Mechanical/Fire Protection/Ceiling Plans open the 1 – 
Ceiling FP view 

2. Click the Systems tab 

3. Click the Sprinklers icon 
4. Use the Type Selector to choose the ¾” Pendent 

5. Click the Place on Face icon 
6. Place one sprinkler at the center of a ceiling tile nearest the center of the room as 

shown in Figure 15.3 

7. Click the View tab then select the Section icon 
8. Place a section mark in front of the sprinkler head that was just placed, as shown 

in Figure 15.3 
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Figure 15.4 First sprinkler placed (left) and section cut view (right) 
9. Place sprinklers in 6 more of the rooms as shown in Figure 15.4. The 8th room will 

become the Fire Riser room. 

TIP 

When copy/pasting repeating items, use the Copy tool  and make sure the 
Multiple option is checked. Select multiple items by holding the SHIFT key 
down. 
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Figure 15.5 Seven placed sprinklers in the ceiling plan view 

15.4 Add Sprinkler mains and branch lines 

1. Open the Mechanical/Fire Protection/Floor Plans/1 – Mech FP view from the 
project browser 

2. In the Systems tab, click the Pipe icon 
3. On the Options Bar change the diameter to 12 inches and the middle elevation to 

-1’0” 
4. Draw a short length of pipe on the exterior of the 8th room as shown in Figure 15.6. 

TIP 
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If ESC is clicked by accident right-click the pipe and click Draw Pipe to 
begin again 

5. Reduce the diameter to 8” and draw a pipe to just inside the exterior wall 
6. Change the Offset to 9’0” 
7. Draw the Pipe across and down the center of the room as shown in Figure 15.6 

Figure 15.6 Initial main pipe drawn with 12” to 8” diameter 
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TIP 

The Detail level: fine and visual style: shaded shows the element render. 
The Detail level: course and visual style: Hidden Line will show the 2D 
symbol annotation as typically seen in construction documentation. 

 
8. Change the diameter to 4” and draw a pipe into each room just past the walls as 

shown in Figure 15.7 
9. Change the diameter to 1-1/2” and draw a pipe just past the sprinkler head as 

shown in Figure 15.7
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Figure 15.7 Reduction of pipes using diameters of 4” and 1-1/2” 
10. Draw a 1 ½” diameter pipe out towards the sprinkler head as shown in Figure 15.8 
11. Change the offset to 9’6” and change the diameter to ¾” 
12. Draw a pipe from the 1/12” pipe to the center of the sprinkler and Revit will connect 

it automatically. See Figure 15.8 for reference. 
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Figure 15.8 Pipe main and branch lines connected to the sprinkler head shown in 
2D plan view (left) and in 3D view (right) 

15.5 ADD PIPE FITTINGS, VALVES, AND FIRE 
DEPARTMENT INLETS 

1. Go to the Systems tab 

2. Click the Pipe Fittings icon 
3. Use the Type Selector to choose the Cap – Threaded – MI – Class 300 Standard 
4. Hover the cursor over the end of the pipe that runs past the sprinkler. When the 

endpoint highlights click once to place the cap as shown in Figure 15.9 
5. Cap the end of all 6 pipes 
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Figure 15.9 Cap placed on the end of the branch pipe shown in plan view (with the 
hidden line style selected) 

6. Go to the Systems tab 

7. Click the Pipe Accessory icon 
8. A message window will prompt to load a family. Select yes. If this message does 

not appear then click the Load Family icon 
9. Follow the file path: Pipe/Valve/Backflow preventers 

10. Choose the Double Check Valve 2.5-10in and click Open 
11. Use the Type Selector to choose the 8” Double Check Valve. Adjust the main pipe 

to fit the accessory before the 9’0” offset. See Figure 15.10 for reference. 

TIP 

The 9’ offset may need to be moved to fit the Valve. Select the vertical 
pipe and use the move tool to adjust room. The option bar may be used to 
check “Rotate after placement” if the pipe is showing the wrong direction. 

 

12. In the Systems tab click the Mechanical Equipment icon 

13. Click the Load Family icon 
14. Follow the file path: Fire Protection/Connections 
15. Choose the Fire Department Inlet Connection – 3-way flush plate 
16. Place the element on the exterior face of the exterior wall as shown in Figure 15.10 
17. Select the flush plate element 

18. Click THE blue  sign that appears farthest away from the flush plate 
19. On the Options Bar make sure the diameter is set to 2 ½” and the offset is 2’4” 
20. Draw a pipe to just inside the wall 
21. Change the offset to 9’0” and draw a pipe out then to the right to connect with the 

main line as shown in Figure 15.10 
22. Complete steps 17 through 21 for the remaining 2 inlet connections 
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Figure 15.10 Common pipe accessories added to the fire protection system in 2D 
plan view (left) and 3D view (right) 

15.6 ADD FIRE SYSTEM COMPONENTS AND 
CIRCUITS 

1. Go to the Insert tab 

2. Click on the Load Family icon 
3. Follow the file path: Electrical/MEP/Information and Communication/Fire Alarm 
4. Hold the Control key down and select Fire Alarm Control Panel, Fire Alarm Horn 

Strobe – Ceiling Mounted, Manual Pull Station, and Smoke Detector then click 
Open 

5. Go to the Ceiling plan 
6. Click on the Systems tab 

7. Click the Device icon  drop-down menu then click the Fire Alarm icon 

TIP 

If the device does not appear in the plan view, access the Visibility/
Graphics Override and make sure the Electrical Equipment, Electrical 
Fixtures and Fire Alarm Devices boxes are checked 

 
8. Change the Type Selector to Fire Alarm Horn Strobe – Ceiling Mounted 
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9. Click the Place on Face icon  then place the alarm near the center of the room 
10. Change the Type Selector to Plain Smoke Detector 

11. Click the Place on Face icon  then place the smoke detector near the center of 
the room 

12. In the Systems tab click the Electrical Equipment icon 
13. Place the Fire Alarm Control Panel inside the adjacent room where the pipe inlets 

are located 

Figure 15.11 Fire alarm devices placed in plan view 
14. Select the Horn Strobe device 

15. Click the Fire Alarm icon 

16. Click the Edit Circuit icon 
17. On the ribbon choose Panel: 16X19 
18. Hold down the Control key and select the Smoke Detector and Manual Pull alarm 
19. In the Properties Palette change the Load Name to Office 107 Fire Alarm 

20. Click the green  checkmark to finish the Circuit 
21. Repeat steps 13 through 19 to add fire alarm devices and circuits to the remaining 

6 offices. Use the room tag Figure 8.7 to change the Load Name. 
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Figure 15.12 Placed fire alarm devices in plan view 

15.7 ANNOTATE ELEMENTS 

1. Click the Annotate tab 
2. Click the Tag by Category icon 
3. Click the pipe to start the leader 
4. Drag the cursor up and to the left and click 
5. Then drag the cursor to the left and click to finish the leader tag 
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Figure 15.13 Tag by category to annotate pipe diameters 

15.8 FABRICATION OF PARTS 

Equipment parts with specific fabrication parameters are available to download and 
upload into Revit to design accurate MEP systems. 

15.9 LOADING IMPERIAL PARTS 

1. In the Systems tab click the Fabrication Part icon  to open the MEP menu 
2. In the lower right corner click the Settings.. button 
3. Under Fabrication Configuration use the drop-down to choose Revit MEP Imperial 

Content 

4. Select all the items in the left-field then click the Add button 
5. Click OK 
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15.10 ADD AND CONVERTING REVIT SYSTEMS INTO 
FABRICATION PARTS 

1. In the Systems tab click the Duct icon 
2. On the Options Bar change the Height to 6” and the offset to 8’6” 
3. Draw ductwork similar to what is shown in Figure 15.14 

4. Select all of the ductwork then click the Design to Fabrication icon 

Figure 15.14 Fabricated ductwork shown in plan view 
5. Select the main duct that runs along the corridor. The HVAC industry does not 

make ductwork continuous as this is shown. Click the Optimize Length icon 
6. In the MEP Fabrication Parts window select the Service: Ductwork: -2in WG 
7. Scroll to the bottom and select the End Cap S&D 
8. Hover the cursor of the left end of the duct where the red arrow is located. When 

the endpoint snap appears click to place the end cap. 
9. In the MEP Fabrication Parts window select the Group: Hangers 

10. Select the Strut Hanger and place 2 hangers for each section of ductwork 
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Figure 15.15 Ductwork with optimized length adjustments and strut hangers 

15.11 BUILD FROM FRABRICATION PARTS 

1. In the MEP Fabrication Part window change the Service: Ductwork +2 WG and 
Group: Rnd 

2. Select the Spiral Pipe and change the diameter to 12” and the offset to 9’0” in the 
properties palette 

3. In the 1 – Mech FP view place a line of round ducts along the first floor open 
workspace as shown in Figure 15.16 

4. Use the Mitered Elbow to turn the pipes up at a 90-degree angle 
5. In the 3D view place another straight duct 
6. Place another mitered elbow to turn above the second floor 
7. In the 2 – Mech FP continue to draw pipes across the second floor open 

workspace. Make sure the offset it 9’ 0” 
8. Select the Tee part and equally place three to face in toward the space 
9. Select the Straight part and connect ductwork from the Tee’s 

10. Place endcaps at the ends of the ductwork and a series of Conical caps to 
distribute air. See Figure 15.16 for reference. 
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Figure 15.16 Round ductwork shown in 2 – Mech FP and in 3D view 
 
 
 

Chapter 15: MEP - Fire Protection and Fabrication Parts  |  215

www.dbooks.org

https://www.dbooks.org/


Chapter 16: Structural Systems 

16.1 SET UP A STRUCTURAL PROJECT AND LINK AN 
ARCHITECTURAL FILE 

1. Open the Revit application 
2. In the Revit Home Page click New 
3. In the New Project window use the drop-down menu to choose the Systems 

Template 
4. Choose to create a new Project 
5. Click OK 
6. Go to File then Save As 
7. Save the project in a known location under the name Class Project 1 Structural 

Concrete_Last First 

8. Go to the Insert tab and click the Link Revit icon 
9. Link the Class Project 1_Last First.rvt file then click Open 

10. Select the linked file and Pin  the file to the canvas 
11. Go to the Project Browser and open any elevation view 
12. The linked Revit file levels show but are not accessible. The structural template 

default levels may be hidden behind the linked file. Select a level then click and 
drag the hollow circle out to the right as shown in Figure 16.1 

13. Adjust Level 2 height to align to the bottom of the floor slab also shown in Figure 
16.1 

14. In the Architecture tab use the Level icon to add Level 3, 4, and Roof. Rename any 
levels as necessary but do not change the names of corresponding views 

15. Make one last level at -5’0” and rename this T.O. Footing 

Figure 16.1 Levels added to the Structural file 
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16.2 PLACE STRUCTURAL GRIDS 

1. In the Level 1 floor plan view, change the visual style to hidden line and the detail 
level to fine. 

2. Go to the Structural tab, under the Datum panel, select the Grid icon 

3. On the Draw panel choose the pick lines tool 
4. On the Options Bar change the Offset to 1’6” 
5. Select the 7 exterior walls as shown in Figure 16.2 so grids lines are placed on the 

interior spaces 
6. Press escape twice to end the grid command 

Figure 16.2 Seven placed grids using the pick lines tool shown in Level 1 floor plan 
view 

7. Select a grid then click and drag the grips away from the building as shown in 
Figure 16.3. Repeat this step until the ends of all 7 grids are aligned. 

8. Select each grid then check or uncheck the boxes at the end of the grids to turn 
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on and off the bubbles to match what is shown in 16.3 

TIP 

Grips are hollow blue circles located at the end of each grid used to 
change the length. The boxes at the end of each grid line will turn on and 
off the bubble annotation 

 
9. Place the remaining grids and use dimensions strings to correct spans as 

necessary 
10. Rename the horizontal grids by number and the vertical grids using letters 
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Figure 16.3 Completed grid lines placement, renaming, and dimensioning shown in 
Level 1 floor plan 

TIP 

If the dimensions are too hard to read, change the scale located on the View 
Control Bar. 
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16.3 PLACE FOUNDATION WALLS 

1. This section may be easier to complete with the Grid lines temporarily hidden. To 
do this select any grid 

2. On the View Control Bar, select the Temporary Hidden/Isolate icon  – then 
chose Hide Category 

3. On the Structures tab, click the Wall: Structural icon 
4. In the Properties Palette use the Type Selector to find Foundation – 12” Concrete 
5. Click the Edit Type button 
6. In the Type Properties window select Duplicate 
7. Rename it 3’0” Concrete 
8. Next to Structure select the Edit… button 
9. In the Edit Assembly window change the thickness to 3’0” 

10. Click OK to close out of both windows 

11. On the Ribbon choose the Pick lines tool 
12. On the Option Bar change the following parameters 

◦ Depth: TO Footing 
◦ Location line: Finish Face: Interior 
◦ Offset: 0’6” 

13. Hover over an exterior wall until the dashed blue line is on the interior side of the 
line. Click to place the wall. 

14. Do this for each exterior lines as shown highlighted in yellow in Figure 16.4 – Use 
any other tools necessary to complete this task 

Figure 16.4 Foundation walls highlighted, shown in Level 1 floor plan view (left) and 3D 
view (right) 

15. Open the 3D view 
16. In the Properties Palette change Discipline to Coordination 
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17. On the View Control Bar change to a Detailed level and Realistic Visual Style 

16.4 PLACE BEARING FOOTING 

1. Go to the View tab 
2. Use the Plan View drop down to select Structural Plan 
3. In the New Structural Plan window select TO Footing and click OK 
4. Go to the Structure tab 

5. Select the Wall: Structure icon 
6. In the Properties Palette click the Edit Type button 
7. Select Duplicate then rename this element Bearing Foot 4’0”X2’0” 
8. Next to Structure click the Edit… button 
9. Change the thickness to 4’0” 

10. Click OK to close both windows 
11. On the Options Bar change the following Parameters 

◦ Depth: Unconnected at 1’0” 
◦ Location Line: Wall Centerline 
◦ Offset: 0’0” 

12. In the Properties Palette Change the Base Offset to -1’0” 
13. Hover the cursor over a foundation wall then press the tab key until all the 

foundation walls are highlighted. Click once to place all bearing footings. 

Figure 16.5 bearing Footing walls shown in plan view (left) and 3D view (right) 
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16.5 PLACE CONCRETE PIERS AND PILASTERS 

1. In the TO Footing plan view go to the Structure tab 

2. Click the Column icon 
3. Use the Type Selector to choose the 12X18 Column 
4. Click the Edit Type button 
5. Duplicate the element and name it 2’0”X2’0” then click OK 
6. In the Type Properties window change the b value to 2’0” and the h value to 2’0” 

then click OK 
7. On the Option bar change the following parameters 

1. Depth to Height 
2. Unconnected to Roof 

8. Place a column at the intersection of Grid 1 and Grid A 

9. On the Ribbon select the At Grids icon 
10. Click and drag to select all the grid lines 

11. Click the green  checkmark to finish 
12. Select and delete any unnecessary columns 

Figure 16.6 Placed columns shown in plan view (left) and 3D view (right) 
13. In the Level 1 view, go to the Structures tab, under the Foundation panel, select the 

Isolated icon 
14. In the Properties Palette click the Edit Type button 
15. Duplicate the element and name it 4’0”x4’0”x1’0” 
16. Change the following parameters 

1. Foundation Thickness: 1’0” 
2. Width: 4’0” 
3. Length: 4’0” 
4. Then click OK 

17. On the Ribbon, select the At Columns icon 
18. Click and drag to highlight all the columns 

19. Click the green  checkmark to finish 
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Figure 16.7 Completed Columns and Pilasters shown in Plan view (left) and 3D view 
(right – worms eye view – underneath the model looking up) 

20. Save the project and close the Structural Concrete file 

16.6 PLACE STEEL COLUMNS 

1. Repeat the following sections for a new file 

◦ 16.1 to create a new Structural project and name this file Class Project 1 
Structural Steel_Last First 

◦ 16.2 Place Structural Grids 
◦ 16.3 Place Foundation Walls 
◦ 16.4 Place Bearing Footings 

2. In Level 1 Plan view, go to the Structures tab and click the Column icon 
3. Select the 2’0”x2’0” Concrete Column 
4. On the Option Bar change Level to TO Footing with a Depth unconnected for 8’0” 
5. Click to place a column on the intersection of Grid 2 and Grid B 

6. On the Ribbon select the At Grids icon 
7. Click and drag to select all the grid lines 

8. Click the green  checkmark to finish 
9. Select and delete any unnecessary columns 

10. Go to the Structures tab, under the Foundation panel, select the Isolated icon 
11. Select the 4’0”x4’0”x1’0” bearing footing 

12. On the Ribbon, select the At Columns icon
13. Click and drag to highlight all the columns 

14. Click the green  checkmark  to finish 
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Figure 16.8 Concrete Piers and Pilasters shown in Plan view (left) 3D view (right – 
underneath the model looking up) 

14. Open the Level 1 plan view 
15. In the Properties Palette, click on the Edit… button next to Visibility/ Graphics 

Override 
16. Go to the Revit Links tab then uncheck the box to the left of the Architecture class 

file 
17. Click OK 

18. Go to the Structures tab and click the Column icon 

19. Select the Load Family icon 
20. Follow this folder directory 

◦ English Imperial, Structural Columns, Steel, AISC 14.1, HP Shapes – Column.rfa 

21. The Specify Types window will appear. Choose the HP 8×36 
22. On the Option Bar change the height to Roof 
23. Place a column at the intersection of Grid 1 and Grid A 

24. On the Ribbon select the At Grids icon 
25. Click and drag to select all the grid lines 

26. Click the green  checkmark to finish 
27. Select and delete any unnecessary columns 
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Figure 16.9 Steel columns placed shown in 3D view 

16.7 PLACE PERIMETER FRAMING 

1. Open the Level 2 plan view 
2. Go to the Structure tab and select the Beam icon 
3. Use the Type Selector to choose the W12X26 

4. On the Ribbon make sure the Tag On Placement is selected 
5. On the Option Bar make sure the box next to Chain is checked 
6. Click the midpoint on the column at 1/A, drag the cursor to the midpoint on the 

column at 2/A and click again 
7. Continue this chain along the exterior columns as shown in Figure 16.10 
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Figure 16.10 Perimeter beams placed along exterior columns shown in plan (left) and 3D 
view (right) 

8. Use the Type Selector to chose the W8X10 beam 
9. Now add beams in across the interior of the building as shown in Figure 16.11 

Figure 16.11 Interior Beam System placed on interior grid shown in Plan View (left) and 
in 3D view (right) 

10. In the 3D view, select an 8×10 beam 
11. Right click, Select all Instances, then choose In Entire Project 

12. On the Ribbon, click the Copy Icon 

13. Click the Paste drop down arrow then choose Align to Selected Levels 
14. In the window, press and hold the Control key down to select Levels 3, 4, and Roof 
15. Click OK 
16. Repeat the Copy and Paste to selected level steps for the 12×26 beam 
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Figure 16.12 Perimeter beams placed on each level shown in Plan View 

16.8 PLACE BEAM SYSTEM 

1. In the Level 2 Floor Plan view, go to the Structure tab and select the Beam System 

icon 
2. In the Properties Palette change the following parameters 

◦ Beam Type: W Shapes: W12x36 
◦ Layout Rule: Max Spacing 
◦ Maximum Spacing: 4’0” 

3. On the Ribbon, make sure the Tag On Placement icon is selected 
4. Hover over the W12x26 beam between Grids 1/B and 2/B 
5. Click to place the system 
6. Continue this until all systems are placed 
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Figure 16.13 Beam Systems placed shown in Plan View (Shown in 1/18”=1’ scale so 
annotations don’t overlap) 

7. Hover over the edge of one of the beam systems and select it 
8. Right-click, Select all Instances, then choose In Entire Project 

9. On the Ribbon, click the Copy Icon 

10. Click the Paste drop-down arrow then choose Align to Selected Levels 
11. In the window, press and hold the Control key down to select Levels 3 and 4 
12. Click OK 
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Figure 16.14 Beam System placed on level 3 and 4, shown in 3D view 
 

16.9 PLACE JOIST SYSTEMS 

1. Go to the View tab 
2. Use the Plan View drop down to select Structural Plan 
3. In the New Structural Plan window select Roof and click OK 
4. In the Roof View, select all vertical beams by holding down the Shift key 
5. In the Properties Palette, change the z Offset Value to -0’5” 
6. Click Apply 

7. Go to the Insert tab, then select the Load Family icon 
8. Follow this folder directory 

◦ English Imperial, Structural Framing, LH-Series Bar Joist.rfa 

9. The Specify Types window will appear. Choose the 18LH02 
10. Go to the Structure tab then select the Beam System icon 
11. On the Option bar change the following parameters 

◦ Beam Type: 18LH02 
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◦ Check the box by 3D 

12. Hover over the beams and place the system in the same horizontal direction 
13. Go to the 3D view to verify the joists sit on the beams 

Figure 16.15 Joist systems placed shown in Plan View (left) and in 3D view (right) 
 
 
 

230  |  Chapter 16: Structural Systems



Links by Chapter 

Link to Videos: https://www.youtube.com/channel/UCxOAhTBLD4AltcVULZmHH3g/
videos 

 

Links by Chapter  |  231

www.dbooks.org

https://www.youtube.com/channel/UCxOAhTBLD4AltcVULZmHH3g/videos
https://www.youtube.com/channel/UCxOAhTBLD4AltcVULZmHH3g/videos
https://www.dbooks.org/

	Contents
	About the Publisher
	About This Project
	Acknowledgments
	Chapter 1: Revit Interface
	Chapter 2: Walls, Curtain Walls, Windows and Doors
	Chapter 3: Floors, Roofs and Ceilings
	Chapter 4: Stairs, Railings and Ramps
	Chapter 5: Adding - Modifying Families
	Chapter 6: Massing - Conceptual Mass
	Chapter 7: Model In-Place
	Chapter 8: Schematic Design and Room & Color Fill Plans
	Chapter 9: Materials, Visualization and Rendering
	Chapter 10: Details and Annotations
	Chapter 11: Workflow | Worksharing
	Chapter 12: Schedules and Project Phasing
	Chapter 13: Drawing Sets and Construction Documents
	Chapter 14: Site Modeling
	Chapter 15: MEP - Fire Protection and Fabrication Parts
	Chapter 16: Structural Systems
	Links by Chapter

